
DO NOT DISTRIBUTE 

IMPORTANT INFORMATION FOR TESTERS: 

Remember that this is still a draft. It’s pretty solid but I do have some outstanding items. However, 
you can begin your testing. A few things to note: 

1 Testing: In order to properly test this document and demo, you must complete the entire 
installation in the sequence presented in this document. If you install only certain products, I 
cannot guarantee anything. As for the exercises, I would like to have them all tested to confirm 
that the installation works. Also, this should provide you with the best possible experience. 

2 Support: I will be available at tara.english-sweeney@hp.com or through tara.english-
sweeney@jabber.hp.com to handle any technical issues that you run into. I will respond as 
quickly as possible and if necessary, we can set up a call or netmeeting. I am in my office Monday 
through Thursday in New Jersey (EST). 

3 Feedback: Please provide your feedback by tracking changes in the document or using the 
comments feature. If you need help using these features, please check the online help or contact me 
for assistance. I am looking forward to your feedback. However, due to limited cycles: 

— General questions - I am going to ask that you limit feedback to this document and demo. For 
example, if you want to know why an install is done a certain way that is something that 
would go through different channels.  

— Solutions - Please do not provide feedback in the form of a question, such as “why are we 
doing this?” Please provide a direct suggested change. If you want me to include it, please 
find out and tell me what you would like to see added or changed.  

— Formatting- This document has not been edited. Please do not comment on formatting, 
numbering issues, grammar and so on. We will have a full edit performed after the test cycle 
is complete. 

— Editing – Although we will go through a complete edit, please do keep your eye out for 
consistency in terminology. Note that we are using the existing product names and not the 
ones that will be rebranded. 

— Technical accuracy – If you are a somewhat experienced user, please review for technical 
accuracy as well. 

2 Responding to my open items: Please take the time to review my comments and questions 
throughout. If you can answer, please do! 

3 Remember our audience: It is very important to keep in mind that our target audience is HP 
EMPLOYEES NEW TO HP OPENVIEW CONFIGURATION MANAGEMENT SOLUTIONS. 
Therefore, if something is not clear, please let me know and make suggestions on how to clarify 
or simplify whenever possible. 

4 Improvements: If you have any ideas on how to improve this document, please let me know. 
Even if they don’t make it into this version, I will track the items for the next revision. 

5 Experience: If you run into issues that are things that you know how to fix as an experienced HP 
OVCM Solutions user, but that a new user might not know, please let me know. I may consider 
adding a troubleshooting section or adding more information in the appropriate places in this 
version or later. 

6 Glossary: The glossary on the DVD is currently being reviewed by another group. I included it as 
reference although the final version of the glossary will also include additional information about 
how to find terms and how to use Advanced Self Solve. If you do have comments, please send 
them to Janet May (OVCM) at may@hp.com. 

mailto:tara.english-sweeney@hp.com
mailto:tara.english-sweeney@jabber.hp.com
mailto:tara.english-sweeney@jabber.hp.com
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KNOWN ISSUES: 

• Patch manager causes many nvdkits to run causing the processor to reach 100%. This has been 
reported to dev and they have a fix that has not been released. Therefore, we are using a utility 
called MoveRIS in this version to handle this issue. 

• We are currently still using the name Radia in certain cases, including in passwords. This will 
change in future revisions. 

Possible items for next revision: 

• Break/fix scenario for Patches 

• Break/fix scenario for Application Manager 

• Exercise for Configuration Analyzer from creating state files to comparing 

• Exercise for Proxy Server 
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Legal Notices 

Warranty 

Hewlett-Packard makes no warranty of any kind with regard to this document, including, but not limited to, the 
implied warranties of merchantability and fitness for a particular purpose.  Hewlett-Packard shall not be held liable 
for errors contained herein or direct, indirect, special, incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  

A copy of the specific warranty terms applicable to your Hewlett-Packard product can be obtained from your local 
Sales and Service Office. 

Restricted Rights Legend 

Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) 
of the Rights in Technical Data and Computer Software clause in DFARS 252.227-7013. 

Hewlett-Packard Company 
United States of America 

Rights for non-DOD U.S. Government Departments and Agencies are as set forth in FAR 52.227-19(c)(1,2). 

Copyright Notices 

© Copyright 2006 Hewlett-Packard Development Company, L.P. 

No part of this document may be copied, reproduced, or translated into another language without the prior written 
consent of Hewlett-Packard Company. The information contained in this material is subject to change without notice. 

Trademark Notices 

Linux is a registered trademark of Linus Torvalds. 

Microsoft®, Windows®, and Windows® XP are U.S. registered trademarks of Microsoft Corporation. 

OpenLDAP is a registered trademark of the OpenLDAP Foundation. 

PREBOOT EXECUTION ENVIRONMENT (PXE) SERVER 
Copyright © 1996-1999 Intel Corporation. 

TFTP SERVER 
Copyright © 1983, 1993 
The Regents of the University of California. 

OpenLDAP 
Copyright 1999-2001 The OpenLDAP Foundation, Redwood City, California, USA. 
Portions Copyright © 1992-1996 Regents of the University of Michigan. 

OpenSSL License 
Copyright © 1998-2001 The OpenSSLProject. 

Original SSLeay License 
Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) 

DHTML Calendar 
Copyright Mihai Bazon, 2002, 2003 
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Documentation Updates 

This manual’s title page contains the following identifying information: 

• Software Version number, which indicates the software version 

• Document release date, which changes each time the document is updated 

• Software release date, which indicates the release date of this version of the software 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details. 

http://ovweb.external.hp.com/lpe/doc_serv/
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Support 

You can visit the HP OpenView support web site at: 

www.hp.com/managementsoftware/support 

This Web site provides contact information and details about the products, services, and support that HP OpenView 
offers.  

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valuable support customer, you can 
benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit enhancement requests online 

• Download software patches 

• Submit and track progress on support cases 

• Manage a support contract 

• Look up HP support contacts 

• Review information about available services 

• Enter discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract. 

To find more information about access levels, go to: 

www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:  

www.managementsoftware.hp.com/passport-registration.html 

http://www.hp.com/managementsoftware/support
http://www.hp.com/managementsoftware/access_level
http://www.managementsoftware.hp.com/passport-registration.html
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1 About this Guide 

Introduction 

This guide is intended for internal HP employees who must understand, use and possibly support the 
HP OpenView Configuration Management Solutions. The guide covers the following topics: 

• An overview of HP OpenView Configuration Management Solutions products as well as 
information about essential processes. 

• Instructions for installing and configuring the HP OpenView Configuration Management 
Solutions products in this very specific, single server environment to be used for the exercises. 

• Exercises that demonstrate the basic capabilities of the HP OpenView Configuration Management 
Solutions products. 

 
This guide is not intended to be used to set up as a production version of the HP 
OpenView Configuration Management Solutions.  

The primary objective of this guide is to provide a starting point for your journey to understanding 
the HP OpenView Configuration Management Solutions. Once you have an introduction to some of 
the solutions, you can access additional resources to learn more.  

In order to use this document successfully, you must complete the entire installation in the sequence 
presented in this document.  

Audience 

The audience for this book is internal HP employees, such as new OpenView Configuration 
Management personnel, personnel in other OpenView blades, HP Software, HP Services, and other 
hardware divisions. 

Prerequisites 

You must be comfortable using Windows, Active Directory and VMware.  

Summary 

Welcome to Configuration Management Solutions 

This chapter describes the subset of solutions included in this document, as well as about some key 
processes needed to understand the HP OpenView Configuration Management Solutions.  
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Essential Processes 

This chapter provides a look at some of the fundamental processes used by Configuration 
Management Solutions. Before discussing the essential processes, a brief introduction of the Radia 
Client Objects is provided.   

Preparing the HP OpenView Configuration Management Solutions 

Environment 

This chapter describes how to prepare the hardware and install the required software before 
installing the HP OpenView Configuration Management Solutions.  

Installing the HP OpenView Configuration Management Solutions 

Software 

This chapter describes how to install and configure the HP OpenView Configuration Management 
Solutions software. 

Using the HP OpenView Configuration Management Solutions  

This chapter provides exercises intended to be an introduction to the HP OpenView Configuration 
Management Solutions. It is important to recognize that this is simply an introduction to these 
solutions and is by no means comprehensive. 

Advanced Exercises 

This chapter is a follow on to the chapter Using the HP OpenView Configuration Management 
Solutions. It contains an advanced exercise that you may choose to perform based on your comfort 
level with the solutions that you have learned about so far.  

Related Documents 

The following table provides a list of the HP OpenView Management Solutions publications that are 
associated with the HP OpenView products that are detailed in this book.  

 

Table 1 HP OpenView Management Solutions Publications 

Product Publication Title 

HP OpenView Configuration 
Server Using Radia 

User’s Guide for the HP OpenView Configuration Server Using 
Radia 

HP OpenView Administrator 
Workstation Using Radia 

Publisher Guide for the HP OpenView Administrator Workstation 
Using Radia 

System Explorer Guide for the HP OpenView Administrator 
Workstation Using Radia 

HP OpenView Proxy Server 
Using Radia 

Installation and Configuration Guide for the HP OpenView Proxy 
Server Using Radia 
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Product Publication Title 

HP OpenView Management 
Portal Using Radia 

Installation and Configuration Guide for the HP OpenView 
Management Portal Using Radia 

HP OpenView Messaging 
Server Using Radia 

Installation and Configuration Guide for the HP OpenView 
Messaging Server Using Radia 

HP OpenView Policy Server 
Using Radia 

Installation and Configuration Guide for the HP OpenView Policy 
Server Using Radia 

HP OpenView Patch Manager 
Using Radia 

Installation and Configuration Guide for the HP OpenView Patch 
Manager Using Radia 

HP OpenView Packager for 
Windows Using Radia 

User’s Guide for the HP OpenView Extensions for Windows 
Installer Using Radia 

HP OpenView Knowledge 
Base Manager Using Radia 

Installation and Configuration Guide for the HP OpenView 
Knowledge Base Manager Using Radia 

HP OpenView Usage Manager 
Using Radia 

User’s Guide for the HP OpenView Usage Manager Using Radia 

HP OpenView Reporting 
Server Using Radia 

Installation and Configuration Guide for the HP OpenView 
Reporting Server Using Radia 

HP OpenView Radia Clients 
Using Radia 

Installation and Configuration Guide for the HP OpenView 
Software Manager Using Radia 

Installation and Configuration Guide for the HP OpenView 
Application Manager Using Radia 

These documents and others are located in Publications CD\pdfs on the HP OpenView 

Configuration Management Solutions CD-ROM. 

For new documents and updated versions, go to ovweb.external.hp.com/lpe/doc_serv/. 

When using doc_serv to access the documentation, select Radia from the Product list, then select 
the version number and operating system to narrow the search for the appropriate guide. 

http://ovweb.external.hp.com/lpe/doc_serv/
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2 Essential HP OpenView Configuration 

Management Solutions 

The HP OpenView Configuration Management (HP OVCM) Solutions automate the management of 
data on target devices in your enterprise. These solutions manage devices based on parameters that 
you configure. 

 
Note that throughout this guide, when we refer to “you” we are referring to an IT 
administrator unless otherwise noted.  

Using this document, you will install a subset of the solutions and perform some basic exercises to 
provide you with an introduction to HP’s OpenView Configuration Management Solutions. The subset 
of products and components in this guide were selected because they are the most frequently 
installed components. Additional products may be included in future versions of this guide. In this 
chapter, you will learn about the solutions included in this document, as well as about some key 
processes.  

The following are some key characteristics of the HP OVCM Solutions that you will be working with: 

• Desired State Approach 

You can configure and maintain the [desired] state of a device’s operating system, applications, 
and configuration.  If there is a difference between the device’s desired state and the current 
state, HP’s differencing technology determines the precise component-level changes that are 
required and sends only those changes to the managed device.  

• Policy based Management 

You can define entitlements which control the deployment of data to authorized users or target 
devices. For example, an IT administrator may implement a policy permitting access to certain 
financial databases only to a selected workgroup within an organization’s finance department. 
Subsequent changes to entitlements cause data to be installed, changed, or removed for affected 
users or devices.   

• Adaptive Configuration Management 

As the policies change, the current state is differenced and reconfigured to correspond to the 
desired state. 

• End to End Lifecycle Management 

You can automate the policy-based management of data throughout the deployment life-cycle. 
With the HP OVCM solutions you can: 

— Package applications 

— Analyze the impact of packages prior to deployment 

— Discover, collect and report on hardware and software information 

— Configure policy assignments to assign data to the appropriate device or user 

— Distribute and install data across enterprise networks  

— Repair data and configurations through the desired-state process. 

— Deploy patches, service packs, hot fixes and application updates. 

— Remove data from target devices by changing entitlement policies. 

With HP’s OVCM products, you can manage data and continuously configure devices. 
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Terminology 

The following terms are often used throughout this publication, and it may be helpful to become 
familiar with them before using this guide. 

client 

The Client software (such as the Software Manager, Application Manager, Inventory Manager, Patch 
Manager, or Usage Manager) that runs on the managed device and communicates with the 
Configuration Server. 

client connect 

It is the process in which a managed device communicates with the HP OpenView Configuration 
Server Using Radia. 

Configuration Server 

In conjunction with the Configuration Server Database, a server that stores, manages, and distributes 
application package information, and manages policy relationships and information about managed 
devices. This server is the only product that is mandatory in a HP OpenView Configuration 
Management Solutions environment; without it, the infrastructure will not function. 

desired state 

The condition of a device as defined by the configuration parameters you set in the Configuration 
Server database.  These parameters include software, operating system, and policy.   

device 

In this document, a device is a piece of hardware, such as a computer or ATM that may be either a 
managed device or a target device. 

managed device 

A managed device is a piece of hardware, such as a computer or ATM that is recognized and managed 
by the HP OpenView Configuration Management Solutions. 

package 

A package is data that is published as an individual unit. 

policy 

A policy defines what services a user, a target device, or a managed device is entitled to. 

resolution 

It is the process in which values on a device are replaced with those that are required to achieve its 
desired state. These values are retrieved from the Configuration Server during a client connect. 

service 

A service organizes a group of related packages, methods, or behaviors into manageable units. 

target device 

A target device is a piece of hardware such as a computer or ATM (that can become a managed 
device). 
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user or subscriber 

A user or subscriber is the person who uses managed applications on a managed device. 

HP OpenView Configuration Management Solutions 

Overview 

This section contains an overview of the products and components for the HP OpenView 
Configuration Management solutions. Depending on your enterprise's configuration, your 
infrastructure may use any combination of these products and components. Components are shared 
among two or more products. In this section, we will give brief descriptions of all of the products and 
components, but we will concentrate on the subset of products and components that are used in the 
environment that you will create using this guide. 

Configuration Management Solutions can be divided into four categories. 

• HP OpenView Management Applications Using Radia 

• HP OpenView Management Infrastructure Using Radia 

• HP OpenView Extended Infrastructure Using Radia 

• HP OpenView Management Extensions Using Radia 

HP OpenView Management Applications Using Radia 

HP OpenView Management Applications Using Radia are agent-based applications that can be 
installed on target devices in your enterprise. They communicate with HP’s OpenView Configuration 
Management servers to enable you to manage the discovery, deployment, configuration, repair, 
update, and removal of data on devices such as servers, desktops, mobile devices such as laptops and 
handhelds, and specialty devices such as ATMs, point-of-sale and Internet kiosks. 

Once a management application is installed on a target device, the device is considered a managed 
device. 

There are several types of Management Applications (clients) available for communicating with the 
Configuration Server. The Configuration Server stores the configuration parameters and links 
policies to your managed devices.  This server will be discussed in further detail later in this chapter.  
You can install more than one management application on a device to combine features. 

 
Not all management applications are available for all operating systems and architectures. 
Consult the HP OpenView web site or your HP representative for the most current 
information on platform availability. This guide is for Windows only. 

The table below describes the essential functions of each of the Management Application Products. 

Table 2 Management Applications Essential Functions 

Management Application Product Use 

HP OpenView Application Manager 
Using Radia 

Deploys mandatory services to unattended devices. 

HP OpenView Inventory Manager 
Using Radia 

Tracks and reports on hardware and software on 
managed devices. 

HP OpenView OS Manager Using Radia Enables your managed devices to work properly with OS 
Manager for operating system deployment.   
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Management Application Product Use 

HP OpenView Patch Manager Using 
Radia 

Deploys and analyzes vendor's security patches and 
bulletins.  

HP OpenView Software Manager Using 
Radia 

Allows users to install the services that they are entitled 
to. 

HP OpenView Usage Manager Using 
Radia 

Supports monitoring of all application usage.  

HP OpenView Server Management 
Using Radia 

Deploys server applications, manages Windows 
Terminal Server and Citrix applications, and manages 
configuration baselines and configuration files. 

Next you will learn more details about the Management Applications used in this demo environment. 

HP OpenView Application Manager Using Radia 

HP OpenView Application Manager Using Radia enables you to deploy mandatory data to devices 
without user intervention. You, as the IT administrator, control deployments, updates, repairs and 
removals through policy-based entitlements. 

With the HP OpenView Application Manager Using Radia installed on the target device, you can:  

• Deploy mandatory data to unattended devices.  

• Install, remove, verify, repair, and update data on a schedule or immediately. 

• Control application versions. 

For more information, see the Installation and Configuration Guide for the HP OpenView Application 
Manager Using Radia. 

HP OpenView Software Manager Using Radia 

HP OpenView Software Manager Using Radia enables you to offer self-service data management.  You 
control what data is available to your users through policy-based entitlements.  Then, users can 
choose whether to install, update, verify, repair or remove through a service list. 

For more information, see the Installation and Configuration Guide for the HP OpenView Software 
Manager Using Radia. 

HP OpenView Patch Manager Using Radia 

HP OpenView Patch Manager automatically discovers, analyzes, and deploys software patches for 
Windows, Linux, and UNIX platforms.  You as the IT administrator control the patch lifecycle, which 
includes acquisition, testing, conflict analysis, vulnerability assessments, deployment, and ongoing 
management, through policy-based entitlements. 

The Patch Manager: 

• Gathers information about security patches installed on the managed device. 

• Manages the deployment of patches. 

• Monitors the continued security vulnerability compliance of managed devices. 

See the Installation and Configuration Guide for the HP OpenView Patch Manager Using Radia for 
details. 
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HP OpenView Usage Manager Using Radia 

The HP OpenView Usage Manager Using Radia uses parameters that you set in the Configuration 
Server Database to collect data on the patterns of application usage on your managed devices.  This 
data is reported back to the HP OpenView Usage Manager Server for Radia for reporting and analysis. 

For more information, see the User’s Guide for the HP OpenView Usage Manager Using Radia. 

HP OpenView Management Infrastructure Using Radia 

Use the HP OpenView Management Infrastructure Using Radia to maintain desired state information, 
store data packages, automate software management activities, and administer your environment. 
The Configuration Server and the Configuration Server Database are the core of your management 
infrastructure.  

Table 3 Management Infrastructure Essential Functions 

Management Infrastructure Product Use 

HP OpenView Configuration Server Using Radia Configures and maintains desired state 
information for your devices.   

HP OpenView Configuration Server Database 
Using Radia 

Stores the desired state configuration in a 
hierarchical structure. The Configuration Server 
Database resides on the Configuration Server. 

HP OpenView Administrator Workstation Using 
Radia 

Contains tools to configure and maintain your 
environment. 

Next you will learn more details about the Management Infrastructure products used in this demo 
environment. 

HP OpenView Configuration Server Using Radia 

The HP OpenView Configuration Server Using Radia can reside on a single server, or several can be 
installed across a network of servers. Data and information about the users and managed devices are 
stored in the Database on the Configuration Server. The Configuration Server distributes data based 
on policy.  

The Configuration Server: 

• Generates the desired-state based on configuration parameters 

• Can maintain policies in the Database. When a device connects to the Configuration Server, the 
current policy is transmitted and updated on the device. The device that receives the data may be 
a target device or a managed device. If the device was previously unmanaged, it would now be 
considered managed. 

• Contacts devices to have them initiate requests to the Configuration Server according to a 
schedule, upon notification from an administrator, or when requested by the user.  

See the User’s Guide for the HP OpenView Configuration Server Using Radia for details. 

HP OpenView Configuration Server Database Using Radia 

The HP OpenView Configuration Server Database Using Radia, stored on the Configuration Server, 
records your enterprise’s desired state model. This model is made up of the data to be distributed, 
policies which define the services that users or devices are entitled to, and security and access rules 
for administrators.  See the Radia Database Reference Guide for details. 

The database is hierarchically structured as follows: 
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• Files are used to group similar domains. The PRIMARY file is used to define and maintain the 
desired state.  

• Domains are logical file partitions used to group similar classes. The POLICY domain contains 
the classes needed to create users and groups. 

• Classes are templates containing the attributes needed to create an instance. A class represents 
a category of the desired state.  The USER class of the POLICY domain defines users of managed 
applications. It defines all of the attributes necessary to identify the managed device. 

• Instances are actual occurrences of classes.  The attributes of a class instance contain data 
describing one specific entity of that class. For example, a USER instance contains the 
information needed to identify target devices or user. 

• Attributes are data elements of a class. The class contains the definition (e.g., the name, data 
type, description, and length) for each attribute belonging to the class. Each class instance 
created from the class contains a value for each of the attributes defined in the class. For 
example, the NAME attribute of a USER class contains the name of the user. 

Default Files and Domains 

When you install the Configuration Server, LICENSE and PRIMARY are the only two Files available. As 
you use the HP OpenView Configuration Management Solutions, your Database may change.  Some of 
the Management Infrastructure products add other domains.  For example, Patch Manager adds the 
PATCHMGR Domain, and Usage Manager adds the USAGE Domain.  

• The LICENSE file is read-only and is used for Configuration Server processing. This file is for HP 
use only, and should not be modified. 

• The PRIMARY file is where you will find most information regarding software management. 
Within the PRIMARY file, there are seven default domains. 

— Use the ADMIN domain to define administrative rights and rules for connecting classes. 

— Use the AUDIT domain to configure tasks that will inventory assets on your devices.  

— Use the CLIENT domain to configure Client Operations Profiles. This includes defining which 
Configuration Servers, Proxy Servers, and Staging Servers the client computer can use.   See 
the Application Manager Guide for more information. 

— Use the POLICY domain to create users and groups, and to assign users to groups. 

— Use the PRDMAINT domain to store packages for self-maintenance.  The client software uses 
this domain to heal and update itself. 

— The SOFTWARE domain contains information about the software being managed and the 
methods used to deploy the software.  

— The SYSTEM domain contains administrative and process control definitions. 

As you begin to use Configuration Management Solutions, the PROFILE file appears after the first 
device has registered with the Configuration Server. This file contains information that is collected 
from managed devices. This information is used to connect to devices to deploy data managed by the 
HP OpenView Configuration Management Solutions, and to see the configuration of the managed 
device. 

In this guide, you will use the HP OpenView Management Portal Using Radia (a part of the Extended 
Infrastructure) to work with the Configuration Server Database.  More experienced users may use 
the System Explorer, a tool of the Administrator Workstation, for advanced tasks. 

HP OpenView Administrator Workstation Using Radia 

The HP OpenView Administrator Workstation Using Radia tools enable you as an IT administrator to 
manage the Database, prepare data for management, view Client objects, and customize your 
environment. The Administrator Workstation includes the following tools and capabilities: 
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• Packager 
The Packager provides a graphical interface for packaging all data for distribution. The packages 
are published to the Database by using either the Component Selection Mode or the Installation 
Monitor Mode in the Packager. In Installation Monitor Mode, the Packager determines what to 
package by scanning the computer before and after installing the data. It differences the before 
and after scans to determine what changes were made to the computer. These differences make 
up the package that you publish to the Database. In Component Selection Mode, you select the 
individual components that make up the package, such as files, directories, registry entries, and 
links.  See the Installation and Configuration Guide for the HP OpenView Application Manager 
Using Radia for details. 

• Publisher 
The Publisher provides a graphical interface for publishing Windows Installer applications and 
operating system images to your Database in preparation for deployment to your environment. 
Additionally, the Publisher allows for the publication of files in batch mode. Note that the 
Packager is similar; it performs the same function for non-Windows Installer applications. See 
the Publisher Guide for the HP OpenView Administrator Workstation Using Radia for details. 

• System Explorer 
The System Explorer provides an experienced Configuration Management administrator a 
graphical user interface to configure policy and application services stored in the Database. In 
this Guide, you will use the Management Portal to accomplish all of the necessary tasks in the 
exercises. See the System Explorer Guide for the HP OpenView Administrator Workstation Using 
Radia for details. The System Explorer allows advanced administrators to perform the following 
tasks: 

— Modify application packages after the initial publishing process. 

— Establish reuse of application components between application services. 

— Define application service prerequisites. 

— Define policy for application entitlements. 

— Control deployment of application versions. 

— Centralize control for unattended application service updates, install, and repairs. 

• Client Explorer 
The Client Explorer provides a graphical user interface that you can use to view and edit client 
objects on managed devices, as well as diagnose issues by viewing error objects. Client objects 
represent the current state of the managed device. 

 Extended Infrastructure 

Use the Extended Infrastructure to scale software management services across your entire 
enterprise, giving you the ability to manage devices across multiple network segments. The Extended 
Infrastructure can be divided into two categories; products and components. Components are shared 
among two or more products. The software for the components is provided as needed with the 
products. 

Table 4 Extended Infrastructure Essential Functions 

Extended Infrastructure  Use 

HP OpenView Distributed 
Configuration Server Using Radia 

Replicates part or all of your Databases across a network 
of Configuration Servers. 

HP OpenView Management Portal 
Using Radia 

Manages your infrastructure through a Web browser. 
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Extended Infrastructure  Use 

HP OpenView Multicast Server Using 
Radia 

Sends the same resources in one data stream to multiple 
devices at the same time. 

HP OpenView OS Manager Using 
Radia 

Provisions and manages operating systems on target 
devices. 

HP OpenView Patch Manager Using 
Radia 

Deploys and analyzes vendors’ security patches and 
bulletins. Used with the Patch Manager Server. The Patch 
Manager has both a client and server component. 

HP OpenView Proxy Server Using 
Radia 

Uses cache management over HTTP or TCP/IP to store 
and transmit application data dynamically, freeing 
resources on the Configuration Server. 

HP OpenView Staging Server Using 
Radia 

Stores and transmits application data over TCP/IP or 
IPX/SPX, freeing resources on the Configuration Server. 

HP OpenView Usage Manager Using 
Radia 

Assesses patterns of application usage in your 
environment. 

Products 

Through distributed administrative capabilities, vulnerability assessments, and monitoring of 
application usage patterns, Extended Infrastructure products provide a complete analysis of your 
management solution. In this section you will learn more about the Management Portal, Patch 
Manager, Proxy Server, and Usage Manager products which are used in this Guide. 

HP OpenView Management Portal Using Radia 

The HP OpenView Management Portal Using Radia is web-based and provides you with the ability to 
manage your entire environment regardless of location or computing platform. Administrative tasks 
can be distributed to administrators in remote locations based on roles and policies. Some of these 
tasks are deploying Management Applications, detecting the status of installed Configuration 
Management services, managing the Configuration Server Database, and tracking the completion 
status of all Management Portal tasks 

The Management Portal cannot always perform tasks remotely; therefore, the Management Agent, 
which must be installed on a remote managed device, performs these tasks on behalf of the 
Management Portal.  

Some of the functions the Management Portal can perform are the following: 

• Discover and view devices on your network. 

• Set policy and configure the desired state. 

• Remotely start and stop services. 

• Remotely install some of the Configuration Management products, such as the Management 
Applications, the Management Agent, and the Proxy Server. 

• Notify a group of devices to perform an action such as installing software or auditing services. 

See the Installation and Configuration Guide for the HP OpenView Management Portal Using Radia for 
details. 

HP OpenView Patch Manager Using Radia 

HP OpenView Patch Manager eliminates known software vulnerabilities by automating the patch 
management process including acquisition, impact analysis, pilot testing, discovery, assessment, 
deployment, maintenance, and compliance assurance.  This ensures that managed devices are always 
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configured correctly. With it, you can configure acquisition tools in order to automatically collect 
security patches from a vendor’s web-based security patch repository, as well as perform impact 
analysis and pilot testing in order to identify affected applications and devices. 

Figure 1 Patch Management life cycle 

 

Features of the Patch Manager include, but are not limited to: 

• An acquisition tool that can be configured to enable automatic collection of new security patches 
directly from a vendor's web-based depository for security patches. 

• Ability to perform impact analysis to identify affected applications and devices. 

• Automatic and continuous discovery of devices on the network, software products that are 
installed on each device, the collected security patches that are already applied to each software 
product, and identification of software products that the device actually executes. 

• Policy-based management capabilities that interface directly with a variety of existing policy 
sources such as Active Directory, LDAP or SQL databases. 

• Monitoring devices and checking policy to see if they are in compliance. If they are not in 
compliance, devices are automatically updated with the appropriate patches. 

Patch Manager acquires security patches and synchronizes the patch's information in the Database 
on the Configuration Server with the Patch database on an SQL or Oracle Server. During the 
acquisition, the following occurs: 

• The vendor's web site or local data cache is contacted to prepare for the acquisition of Bulletins. 

• Either the information about the Security Bulletins and Service Packs and the actual patch files or 
only the information about the patches is downloaded. The information downloaded contains, 
but is not limited to, detailed data about each patch, such as if the patch has been superseded by 
a more recent patch, and reboot requirements. 

• An XML file is created for each security bulletin acquired and is put in the vendor's folder in the 
Integration Server's directory. These files are called patch descriptor files. 

• The Database PATCHMGR domain is populated with this information 
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• Services are created in the PATCHMGR domain for each of the bulletins acquired. 

• The PATCHMGR domain is synchronized with the SQL database you created. 

If you have already performed an acquisition, only instances that are different are updated. 

See the Installation and Configuration Guide for the HP OpenView Patch Manager Using Radia for 
details. 

HP OpenView Proxy Server Using Radia 

The HP OpenView Proxy Server Using Radia allows data to be locally available to managed devices. 
Managed devices can receive the data over the Local Area Network (LAN) instead of across a Wide 
Area Network (WAN).   Proxy Servers increase scalability while dramatically reducing traffic over the 
network.  When data is cached on the Proxy Server, the demand placed on the Configuration Server is 
decreased, allowing the Configuration Server to allocate more resources to other tasks. 

Placing Proxy Servers at strategic points in your network increases the efficiency at which data is 
transferred. The connection between users and the Proxy Server may be more efficient than the 
connection between the users and the Configuration Server. The factors that determine the efficiency 
of a connection between a server and a device include hardware capability, network bandwidth, 
workload on the servers, network traffic patterns, and the volume of software to be distributed. 

Figure 2 Proxy Server caching 

 

The Proxy Server, when used, is the primary repository for data to be deployed. Once the managed 
device determines the resources needed for its desired state, the device can request those resources 
from the Proxy Server. The Proxy Server provides the following benefits: 

• The ability to choose between having requests made using either HTTP (recommended) or 
TCP/IP. 

• The ability to service multiple, concurrent requests from either protocol source. 

• The ability to have data automatically loaded onto the Proxy Server for distribution when the 
first request comes in from a managed device. This occurs if the data does not already exist on 
the Proxy Server. 

• The ability to automatically send requests to the Configuration Server for processing if the Proxy 
Server cannot handle the request. 

See the Installation and Configuration Guide for the HP OpenView Proxy Server Using Radia for details. 
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HP OpenView Usage Manager Using Radia 

You can use the HP OpenView Usage Manager Using Radia to assess patterns of application usage in 
your environment. This allows you to facilitate adherence to license agreements, re-provision 
licenses if needed, and monitor user productivity. 

The Usage Manager monitors the use of every application on all of your devices. This enables you to: 

• Enforce corporate standards by identifying non-standard software and software versions in use 
within your enterprise. 

• Implement license tracking, giving you the ability to purchase and maintain only those licenses 
that are needed. 

• Prioritize distribution of content based on the information captured about usage. 

• View reports of the actual use of application resources. 

The Usage Manager can be used in your existing environment whether or not you are currently using 
HP OpenView Configuration Management Solutions for data distribution.  

See the User’s Guide for the HP OpenView Usage Manager Using Radia for details. 

Components 

Some products share components to consolidate communications and facilitate data flow. Shared 
components include the Integration Server, Messaging Server, and the Reporting Server. 

Table 5 Shared Components Essential Functions 

Component Use 

Integration Server All the products using the Integration Server are loaded from a single 
Windows Service called "Integration Server”.   

The Integration Server is used by Management Portal, Proxy Server, Policy 
Server, and Patch Manager, 

Reporting Server The web-based Reporting Server allows you to use data from SQL or 
Oracle for reporting.  

The Reporting Server is used by Patch Manager, Usage Manager, Inventory 
Manager, and Server Management. 

Messaging Server The Radia Messaging Server routes data from client objects to the 
appropriate Radia Server. 

The Messaging Server is used by Radia Management Portal, Radia Patch 
Manager, Radia Inventory Manager, and Radia Server Management. 

HP OpenView Integration Server Using Radia 

Many of the Extended Infrastructure products use the Integration Server, such as the Management 
Portal, the Proxy Server, the Policy Server, and the Patch Manager Server.  Each product is composed 
of modules that reside in the Integration Server's modules directory. These components use the same 
core Integration Server files, and run under the same process. The Integration Server does not have 
its own install.  It is loaded if the Infrastructure product needs it, and it is not already installed. 

Benefits of the Integration Server are: 

• All the products using the Integration Server for Windows can be loaded from a single Windows 
Service called "Integration Server". 

• When the Integration Server starts, it scans its configuration file and attempts to load all the 
products marked for loading. 

• Each product loaded from the Integration Server is separately licensed. 
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• The Integration Server provides Web services that are shared by all loaded modules.  This 
integration provides increased performance, efficiency, and maintenance ease. 

HP OpenView Reporting Server Using Radia 

The HP OpenView Reporting Server Using Radia allows you to use SQL data for reporting.  As part of 
the Extended Infrastructure, the web-based Reporting Server allows you to query the data in the 
Inventory, Patch Manager, and Usage Manager databases and create detailed reports. 

Figure 3 Reporting Server environment 

 

The Reporting Server provides the following additional value to the infrastructure: 

• Connections to SQL Databases:  The Reporting Server can access any SQL database, such as those 
for Inventory Manager, Patch Manager, and Usage Manager. However, all SQL databases accessed 
by the Reporting Server must exist on a single SQL or Oracle Server.  

• Connections to LDAP Directory (optional):  The Reporting Server supports optional access to an 
existing LDAP directory in your enterprise. Access to an LDAP directory allows you to filter 
report data according to the directory entries. 

See the Installation and Configuration Guide for the HP OpenView Reporting Server Using Radia for 
details. 

HP OpenView Messaging Server Using Radia 

The HP OpenView Messaging Server Using Radia is a service that continually monitors a pre-defined 
location on the server and routes data to external destinations. The Messaging Server provides retry, 
rerouting, and failover capabilities to ensure all data is transferred efficiently and reliably. 
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If the Messaging Server is installed on the same server as the Configuration Server, the Messaging 
Server receives data from managed devices.  Then, the Messaging Server transfers the data to the 
appropriate Integration Server. For example, if Patch Manager data is being transferred, the 
Messaging Server will move the data to the Integration Server from which the Patch Manager is 
loaded.  From the Integration Server, the data is mapped to the appropriate SQL database, such as 
Patch. 

The Radia Messaging Server uses Data Delivery Agents (DDAs) to handle the routing of client objects 
for patch management, inventory management, and usage management to the appropriate reporting 
database. Using data delivery agents, data can be posted directly to an ODBC database, or, it can be 
forwarded securely to another directory or server (such as a Store and Forward Messaging Server) 
using HTTPS or HTTP. 

The Messaging Server runs on all Windows and UNIX platforms supported by the Configuration 
Server. The Messaging Server can: 

• Route a single message to multiple destinations. 

• Automatically retry a delivery. 

• Re-route messages to a new host after several unsuccessful delivery attempts. 

See the Installation and Configuration Guide for the HP OpenView Messaging Server Using Radia for 
details. 

Using the Messaging and Reporting Servers 

To show how the Messaging Server and Reporting Server work together, the following is an example 
of inventory collection.  The HP OpenView Inventory Manager Using Radia client discovers 
configuration information on the managed device, and reports the results to the Messaging Server.  
The Messaging Server moves the information to a SQL database so that you can use the Reporting 
Server to view the results. Web-Based Enterprise Management (WBEM) enables information such as 
the amount of RAM in a computer, hard disk capacity, process type, and versions of operating 
systems to be extracted from computers, routers, switches, and other networked devices. Windows 
Management Instrumentation (WMI) is Microsoft's implementation of WBEM for Microsoft Windows 
platforms. 

Figure 4 Inventory results report to an ODBC source 

 

1 The client communicates with the Configuration Server, and sends client objects to the 
Configuration Server. Some objects are always sent and others are sent as a result of an 
Inventory Audit Service being performed. The following information may be sent: 

— The APPEVENT object that describes the most recent service events. 

— The ZCONFIG object that contains information on the device's hardware configuration. 

— If a WBEM audit is performed and the client is a WBEM consumer, then WBEM objects will 
be sent. 
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2 The Radia Messaging Server posts the objects to the appropriate ODBC data source. All 
inventory-related and audit objects are posted to the Inventory database. 

3 The Radia Reporting Server accesses the data and allows you to view the inventory reports. 

Note that the Reporting Server allows you to view reports for Patch Manager, Usage Manager, and 
Server Management. 

Management Extensions 

Radia Management Extensions provide integration and extended enterprise functionality. They allow 
Radia to interface with other technologies such as Lightweight Directory Access Protocol (LDAP) and 
Secure Sockets Layer (SSL).   Similar to the Extended Infrastructure, Management Extensions can be 
divided into common components, such as the Knowledge Base Manager, and products, including 
Extensions for Windows Installer, Policy Server, Adapter for SSL, the Publishing Adapter, and the 
Systems Management Adapters.  The table below describes the essential functions of each of the 
Management Extension products. 

Table 6  Management Extensions essential functions 

Management Extension  Use 

HP OpenView Adapter for SSL Using Radia Maintains the safety and confidence of 
transmitted information. 

HP OpenView Extensions for Windows Installer 
Using Radia 

Publishes and manages Windows Installer 
applications. 

HP OpenView Policy Server Using Radia Uses external directory services to implement 
policy. 

HP OpenView Publishing Adapter Using Radia Creates fully automated, unattended updates to 
application packages. 

HP OpenView Systems Management Adapters 
Using Radia 

Exchanges data with other vendors' products 

Next you will learn more details about the Management Extensions used in the exercises at the end of 
this Guide. 

HP OpenView Policy Server Using Radia 

The HP OpenView Policy Server Using Radia is a Web server used for administration purposes such 
as mapping services to users in an external directory tree. Connections made in the Configuration 
Server Database to Lightweight Directory Access Protocol (LDAP) directory are used to determine 
what services should be distributed and managed for the user that is currently logged on by querying 
the Policy Server. 

The Policy Server integrates with external LDAP directory servers and SQL databases to enable single 
source points of control for user authentication, access policies, and user entitlement. These LDAP 
directory servers include Microsoft Active Directory, Novell NDS, and other vendor's LDAP servers, 
as well as Oracle, Sybase and Microsoft SQL-based databases. 
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Figure 5 Policy Server integrates with LDAP and SQL 

 

For more information, see the HP OpenView web site and the Installation and Configuration Guide for 
the HP OpenView Policy Server Using Radia Guide. 

HP OpenView Knowledge Base Manager Using Radia 

The HP OpenView Knowledge Base Manager Using Radia is a component of Management Extensions. 
The Knowledge Base database may be either a SQL Server or an Oracle database configured in your 
environment. The Knowledge Base is populated with data in the form of state files. State files consist 
of data that represent the current state of an application. This data is acquired by the Knowledge 
Base Manager from a continuously monitored user-specified directory referred to as a collection 
point.  When data is detected in this collection point, it is automatically transferred to the Knowledge 
Base.  The collection point is populated by one or more products including the Patch Manager, Usage 
Manager, and Packager for Windows Installer. From here, data analysis can take place, using the 
Configuration Analyzer. Application usage can be viewed with the Reporting Server. 

The Knowledge Base Manager is capable of importing several types of state files including: 

• Configuration Server Service/Package component extracts 

• State files built by the Radia Extensions for Windows Installer components 

• Usage Manager collection files 

• State files built by the Radia Patch Manager. 
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Figure 6 Knowledge Base Manager 

 

See the Installation and Configuration Guide for the HP OpenView Knowledge Base Manager Using 
Radia for details. 

Infrastructure Example 

Now that you have some familiarity with Configuration Management Solutions, the following 
example shows how these products and components might work together. 

Suppose you wanted to be able to do the following: 

• Manage mandatory data. (HP OpenView Application Manager Using Radia) 

• Analyze and manage security vulnerabilities. (HP OpenView Patch Manager Using Radia) 

• Use your existing external LDAP directory services to create entitlements. (HP OpenView Policy 
Server Using Radia) 

• Place servers with your data in network strategic locations to your target devices. (HP OpenView 
Proxy Server Using Radia) 

• Distribute management of the devices across your enterprise. (HP OpenView Configuration 
Server Using Radia and the HP OpenView Distributed Configuration Server Using Radia) 

In this case, you would want to combine the functions of the Application Manager, the Configuration 
Server, the Policy Server, the Proxy Server, the Distributed Configuration Server, and the Patch 
Manager. A diagram of your network might be similar to Figure 7 on page 29. 
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Figure 7 Create a Radia Patch Manager environment. 
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3 Essential Processes 

This chapter provides a closer look at some of the fundamental processes used by the HP OpenView 
Configuration Management Solutions. Before discussing the essential processes, a brief introduction 
to Radia Client Objects is provided to help you better understand the processes. 

About Radia Client Objects 

When a device connects to the Radia Configuration Server, information is exchanged between the 
client and the Radia Configuration Server. This exchange is called resolution. During resolution, the 
Radia client checks the status of services, and updates the Radia Configuration Server with 
information from objects stored on the device. The resolution process will be described in more 
detail later in this chapter. 

Radia Client Objects are stored in a directory, called IDMLIB, on the managed device. After installing 
the client software and connecting to the Radia Configuration Server, you can use Radia Client objects 
to answer questions such as: 

• What is the hardware configuration of the managed device? 

• Was the service successfully installed? 

• When was the service installed? 

• What is the managed device’s name, and who was the last user logged on? 

• What are the possible data sources for this managed device? 

While there are multiple Radia objects on a managed device at any time, there is a core group of 
objects that supply information and the status of the current client connect. These objects are 
referred to in some of the processes discussed in this chapter. The table below includes information 
on when one of these objects is created or updated, and a brief summary of what the object includes. 
There are other objects created during the client connect, only some are noted here. Check the HP 
OpenView web site and the Installation and Configuration Guide for the HP OpenView Application 
Manager Using Radia for information on other client objects. 

Table 7 Client Objects 

Object Name Description 

PREFACE PREFACE is sent to the Radia Configuration Server at every phase of a client 
connect. It contains parameters used for the current connect such as the type of 
connect, the user name, and if the list of applications is being updated. 

ZCONFIG ZCONFIG is created at the start of the client connect process. It contains basic 
hardware information for the client computer such as processor, operating 
system, and drives. 

APPEVENT APPEVENT reports on the status of application events, such as installation, 
verify, repair, and removal. 

ZMASTER ZMASTER is sent to the Configuration Server at the beginning of the client 
connect.  It includes information to identify the managed device for 
implementing policy, such as user identification, operating system, and 
computer name. 
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The Client Connect Process 

The purpose of the client connect process is to ensure that the device matches its desired state. The 
desired state embodies the data and entitlements for each device. A model representing the desired 
state for each device is stored in the Database. 

The client connect process is initiated when a client object is sent to the Configuration Server.  
Typically, this is the ZMASTER object which contains information about the managed device, such as 
the device’s identity and IP address. 

The ZMASTER object is sent to the Configuration Server as a result of the following events: 

• A scheduled Timer event. 

Timers are usually associated with a particular service and can be triggered periodically or 
randomly within a certain time period using the Application Manager or Inventory Manager 

• A Notify sent by the Configuration Server to the device.  A Notify is a message sent to the 
managed device telling the device to start a client connect using the Application Manager or 
Inventory Manager. 

• A refresh of the Service List on the managed device in the Software Manager. 

To manage services, the administrator entitles the services, first.  Then, the user uses the Service 
List to manage the installation, verification, removal, repair, and update of a service. 

The connect process involves the following three stages: 

1 Tree Differencing to download the new objects from the Configuration Server, create the 
difference objects (delta objects), and identify any data that needs to be retrieved. 

2 Data Transfer in which data is downloaded to a temporary location on the device.  

3 State Machine processing to install files from the temporary location to the live location and 
create the new desired state objects to manage services. 

Tree Differencing 

During the Tree Differencing phase of the client connect, the client identifies which files it needs to 
bring the device to the desired state. The client differentiates the data between the configuration 
information on the device and the Configuration Server. First, the client sends the ZMASTER object to 
the Configuration Server. Then, the Configuration Server builds the desired state based on the 
parameters designated for the user in the ZMASTER object. The desired state is sent back to the 
device as a new object, where the client synchronizes the old and new objects between the server 
and the device. 
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Figure 8 Tree differencing 

 

Tree differencing works by using a reference list, which is like an object dictionary; it stores the 
different names for a particular class. The reference list is updated whenever a change is detected 
within the tree, in the "branches" or "leaves". The differencing algorithm relies on a name algorithm 
to generate predictable names for the difference object, the downloaded object, and the branch 
object. 

After generating the difference object, the client identifies if it needs to get any data files or install 
applications to bring the device to its desired state. The client requests and downloads these files 
from the Configuration Server, a Proxy Server, or a Staging Server during the Data Transfer stage of 
the client connect process. 

Data Transfer 

The Data Transfer phase of the client connect begins when the client sends a request for these files to 
the Configuration Server. If the client is configured to retrieve files from the Proxy Server or the 
Staging Server, the client checks those servers for the files it needs. If the files are present, the client 
downloads them. If any of the files cannot be retrieved from the Proxy Server or the Staging Server, 
the client retrieves the files from the Configuration Server. If the client is not configured to use the 
Proxy Server or the Staging Server, the files are retrieved directly from the Configuration Server. 

The Configuration Server, the Proxy Server, or the Staging Server send the data to the device in a 
compressed form and copies it to a pre-defined directory on the device called IDMDATA. The 
IDMDATA directory is used as a temporary storage location on the managed device for these 
compressed files. Once the files are decompressed and installed on the managed device, the 
compressed files are erased automatically if configured. 
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Figure 9 Data transfer 

 

If you have multiple Radia Configuration Servers, Radia Proxy Servers, or want to store files for 
managing applications on a local CD-ROM, you may want to reconfigure the Radia Client before 
connecting to the Radia Configuration Server. Use Radia Client Operations Profiles to prioritize and 
set criteria for where the managed devices should obtain their data from.  See the Installation and 
Configuration Guide for the HP OpenView Application Manager Using Radia or the Installation and 
Configuration for the HP OpenView Software Manager Using Radia for details. 

State Machine 

After the client downloads the files needed to bring the device to its desired state during the Data 
Transfer phase, the client installs these files from the IDMDATA directory. The client erases the 
compressed files after they have been installed on the managed device. Then, the client merges the 
original object from the client with the differenced object created during the Tree Differencing 
Process. 



34 Chapter 3 

Figure 10 State machine 

 

At the end of the client connect process the managed device’s configuration should match its desired 
state built in the Database. 

The Resolution Process 

The Configuration Server uses the resolution process to build the device’s desired state.  Remember 
that the Database which resides on the Configuration Server contains the configuration parameters 
to create the desired state. The client submits a request to the Configuration Server in the form of a 
client connect and the Configuration Server performs a resolution process in response to that 
request. 

Figure 11 Resolution Process 

 

In this section, it is important for you to understand how the different parts of the Configuration 
Server Database are referred to.  Recall that in the Essential HP OpenView Configuration 
Management Solutions chapter, we defined the different elements of the Configuration Server 
Database. 
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Table 8 Configuration Server Database Usage Examples 

Element Example 

Files PRIMARY 

 

Domains PRIMARY.SOFTWARE  

May also be referred to as the SOFTWARE Domain in the PRIMARY File. 

Classes PRIMARY.SOFTWARE.ZSERVICE  

May also be referred to as the ZSERVICE Class in the SOFTWARE Domain in 
the PRIMARY File. 

Instances PRIMARY.SOFTWARE.ZSERVICE.AMORTIZE 

May also be referred to as the AMORTIZE Instance of the ZSERVICE Class in 
the SOFTWARE Domain in the PRIMARY File. 

The ZMASTER object is sent to the Configuration Server during the client connect. The ZMASTER 
object contains information about the managed device necessary to run, such as the identity of the 
user or device and the IP address of the device.  

The Configuration Server stores the ZMASTER object in global memory. Global memory is a 
temporary storage area in the Configuration Server. The Configuration Server maintains the contents 
of the global memory for the duration of the resolution process.  You can view the ZMASTER object 
using the Client Explorer.  Below, you can see some of the attributes in the ZMASTER client object.  
Note that the ZUSERID is alee.  This is how the Configuration Server will know how to resolve policy 
for this user. 

Figure 12 ZMASTER object 

 

After storing ZMASTER in global memory, the Configuration Server finds the Process in the 
Configuration Server Database associated with ZMASTER. This is called the process entry point. Its 
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location is referred to as SYSTEM.PROCESS.ZMASTER or the ZMASTER instance of the PROCESS class 
in the SYSTEM Domain. 

 

The Configuration Server reads each attribute of SYSTEM.PROCESS.ZMASTER. As a result of an 
attribute, the Configuration Server may: 

• Set variable values. 

• Evaluate an expression.  

• Execute a method or executable.  

• Connect to other instances in the Configuration Server Database.  

 
For the purposes of explanation, the view of the Configuration Server Database shown 
in this section are all taken using the System Explorer, an administrative tool for 
advanced administrators.  Remember that you will be using the Management Portal to 
manipulate the Configuration Server Database in the exercises. 

If there is a connection to another instance, the Configuration Server processes the connected 
instance. Then, the resolution process returns to that original instance at the next attribute after the 
connection attribute. For example, in Figure 6, the first connection instance links to 
POLICY.USER.&(ZMASTER.ZUSERID). After evaluating all the attributes in 
POLICY.USER.&(ZMASTER.ZUSERID), the resolution process will return to the 
PRIMARY.SYSTEM.PROCESS.ZMASTER instance at the next attribute.  In this case, the attribute 
connects to the PUT_PROF_ZMASTER method in the SYSTEM Domain. 
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Figure 13 PRIMARY.SYSTEM.PROCESS.ZMASTER instance 

 

During resolution, the Configuration Server performs symbolic substitution to set values and connect 
to other instances. For example, in SYSTEM.PROCESS.ZMASTER there is a connection to 
POLICY.USER.&(ZMASTER.ZUSERID). The Configuration Server substitutes the value of the ZUSERID 
from the ZMASTER object that is in global memory. In Figure 12 on page 35 the value of ZUSERID is 
alee. Therefore, the resolution process will connect to POLICY.USER.ALEE, and resolve that instance. 

Figure 14 POLICY.USER.ALEE instance 

 

In Figure 14 above after setting a number of variables, the first connection attribute connects to the 
AMORTIZE instance in the ZSERVICE class of the SOFTWARE Domain.  
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Figure 15 ZSERVICE.AMORTIZE instance 

 

An instance of the Service class links to packages. Recall that a service organizes a group of related 
packages, methods, or behaviors into manageable units. The figure above begins with an expression 
in the ZSTOP000 attribute.   An expression allows alternative paths to be taken in a given resolution, 
based upon variable data. In this case, the expression checks to be sure that the operating system of 
the client computer is allowed for the Amortize software. 

A service instance connects to package instances. In our example, the first package instance is to 
SOFTWARE.PACKAGE.AMORTIZE2_W95. The Configuration Server looks at the instance. After setting 
some of the attributes, there is another expression. If the managed device’s operating system is either 
Windows 95 or Windows 98, the resolution process continues with this instance, connecting the file 
instances, registry entries, path instances, and shortcuts. If the client has another operating system, 
resolution returns to SOFTWARE.ZSERVICE.AMORTIZE at the next connection instance. 

Eventually, the resolution process will return to the User instance, finish resolving it, and return to 
the process entry point, the SYSTEM.ZPROCESS.ZMASTER instance. Referring back to Figure 13 on 
page 37, the next attribute connects to the method, PUTPROF_ZMASTER. A method is a program that 
performs functions based on certain parameters. The PUTPROF_ZMASTER method instance is shown 
in Figure 16 below. 

Figure 16 ZMETHOD.PUTPROF_ZMASTER instance 

 

The Configuration Server executes a final method in the entry point instance, which passes ZMASTER 
as a parameter. This causes the contents of the ZMASTER object in global memory to be written to 
the PROFILE file of the Configuration Server Database. 

After all of the attributes in the SYSTEM.PROCESS.ZMASTER instance are evaluated, the resolution 
process completes. 
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Installations and Exercises 

In the next chapter of this Guide, you will install and configure the HP OpenView Configuration 
Management Solutions products necessary to complete the exercises. In the final chapter, you will 
perform tasks using these products and components to help you begin to understand how to use the 
Configuration Management Solutions.  Keep in mind that for the purposes of demonstration, only a 
subset of the products and components, and their features will be used. The tasks you will cover are: 

1 Deploying Radia clients to target devices  

a Use Management Portal to deploy the Radia clients to a target device. 

2 Publishing data 

a Use Publisher to prepare services. 

b Use Management Portal to view the new services created by the Publisher. 

3 Managing Policy 

a Managing Optional Services with Software Manager  

– Use Management Portal to entitle the user to an optional service. 

– Use Software Manager to install the service. 

– Use Software Manager to repair a broken service. 

b Managing Mandatory Services with Application Manager  

– Use Management Portal to entitle the user to a mandatory service. 

– Use Management Portal to install the service. 

4 Gathering Hardware and Software Inventory 

a Modify and entitle Audit services using Management Portal. 

b Use Management Portal to send an Application Manager Notify to install the service. 

c View the results of the audit using Reporting Server. 

5 Managing Security Vulnerabilities with HP OpenView Patch Manager Using Radia 

a Acquire patches from a local data cache.  (Note that in a production Patch Manager 
environment, you will acquire the patches directly from the operating system’s vendor.). 

b Use Management Portal to entitle the target device to the vulnerability scan. 

c Use Management Portal to send an Application Manager Notify to install the service. 

d View the target device’s security compliance with Reporting Server. 

e Use Management Portal to entitle the target device to the relevant patches. 

f Use Management Portal to send an Application Manager Notify to install the service. 

g View that the target device is now in compliance with Reporting Server. 

6 Tracking Application Usage with HP OpenView Usage Manager Using Radia  

a Use Management Portal to configure the Usage service. 

b Use Management Portal to entitle the target device to the service. 

c Use Management Portal to send an Application Manager Notify to install the service. 

d View the results with Reporting Server. 
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4 Preparing the HP OpenView 

Configuration Management Solutions 

Environment 

This chapter describes the required hardware for the host machine and how to open and configure 
the virtual machines prior to installing HP OpenView Configuration Management Solutions used in 
this demo. 

A host machine is any machine with the required hardware that can run the VMware software.  

A virtual machine is a standalone machine running in a virtual environment. Consider the virtual 
machine a separate machine. Depending on the hardware, a host machine can support multiple 
virtual machines with various operating systems. For example, you may have a Windows XP host 
machine running VMware workstation with two VMware machines ⎯one running Windows 2003 
Server Enterprise Edition and the other running Windows XP SP2.  

For this guide, we have provided two VMware images for you to use⎯ a server and a target device. 
You will learn how to open these virtual machines on your host machine. 

 
This is intended to be a demonstration for internal use only. Do not put the environment 
created with this guide on the HP Network or use it in a production environment.  

Also, use only the resources provided on the DVD to create this environment. 

Host Machine Requirements 

The host machine is the machine that has VMware 5.5 running and will contain the target and server 
images. This machine must have the following: 

• A minimum of 1.5 GB – 2 GB memory  

• 20 GB free disk space 

• VMware workstation 5.5 (Note that the DVD does not contain VMware 5.5. You can download a 
30-day trial version from www.vmware.com.) 

 
Do not perform the HP OpenView Configuration Management Solution installations 
covered in this guide on the host machine. All installations should be performed on the 
virtual server machine in order for this environment to work properly. 

Setting Up Your Virtual Environment 

This section describes how to prepare your virtual environment. Your virtual environment consists 
of two pre-configured virtual machines, a server (HPOV Config Mgmt Server) and a target device (HP 
OVCM Target Device).  

The server machine is where you will perform all of the HP OpenView Configuration Management 
Solution installations covered in this guide. 

http://www.vmware.com/
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To open the virtual server machine 

1 From the HP OpenView Concepts and Processes DVD, copy \VMware_images\HP OVCM 
Server to your host machine.  

2 Open …\HP OVCM Server and right-click HP OVCM Server1.zip and select Extract to 

here.  

3 When the files are extracted, delete HP OVCM Server1.zip and the files HP OVCM 
Server1.z01 through HP OVCM Server1.z10. 

4 Go to Start→All Programs→VMware→VMware Workstation.  

The VMware Workstation software opens. 

5 Go to File→Open. 

6 Browse to the location where you saved the HP OVCM Server folder, open the folder, select 
Windows Server 2003 Enterprise Edition.vmx and click Open. 

The HPOV Config Mgmt Server tab opens. 

 

7 Right-click the HP OV Config Mgmt Server tab and select Settings. 

8 Click the Options tab. 

9 In the Settings column, select Snapshots. 

10 In the General area, clear the Disable snapshots check box. 

11 Click OK. 

12 Click Start this virtual machine. 
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When you see the message asking whether you want to create a new unique identifier 
(UUID). Click Create and then OK. 

13 When the Welcome to Windows dialog box opens, click in the window and then press CTRL + 
ALT + Insert. 

14 Log on with the user ID Administrator and password radia.  

15 Click OK. 

16 You may need to change the subnet because this information is automatically assigned when you 
install VMware. In order for this image to work: 

a Go to Edit→ Virtual Network Settings.  

b Check the Summary tab to see if VMnet1 is set to subnet 192.168.5.0. If it is not, click the 
Host Virtual Network Mapping tab and click the arrow next to VMnet1 and select Subnet. 
Set the IP address to 192.168.5.0 and the Subnet Mask to 255.255.255.0.  

17 You may also need to remove the DHCP server from VMware. To do this, select the DHCP tab 
and then select the appropriate Virtual Network, VMnet1 and click Remove. 

 
Consider taking a snapshot of your target device while it is in a clean state. This way, 
you can quickly revert to the snapshot if necessary. To do this, right-click the HP OV 
Config Mgmt Server tab and select Take Snapshot. Type a name such as Initial 

Server Image and click OK. It may take a few minutes for the snapshot to be 
completed.  

To open the virtual target machine 

1 From the HP OpenView Concepts and Processes DVD, copy \VMware_images\HP OVCM 
Target to your host machine.  

2 Open …\HP OVCM Target and right-click HP OVCM Target1.zip and select Extract to 

here.  

3 When the files are extracted, delete HP OVCM Target 1.zip and the files HP OVCM 
Target1.z01 through HP OVCM Target1.z08. 

4 In VMware, select File→ Open. 

5 Browse to the location where you saved the HP OVCM Target folder, open the folder, and select 
Windows XP Professional.vmx. 

6 Click Open. 

7 Right-click the HP OVCM Target Device tab and select Settings. 

8 Click the Options tab. 

9 In the Settings column, select Snapshots. 

10 In the General area, clear the Disable snapshots check box. 

11 Click OK. 

12 Click Start this virtual machine. 

 
When you see the message asking whether you want to create a new unique identifier 
(UUID). Click Create and then OK. 

13 When the Welcome to Windows dialog box opens, click in the window and then press CTRL + 
ALT + Insert. 
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14 Log on with the user ID Administrator and password radia. Confirm that the Log on to drop 
down list box is set to DEMO. 

 
Consider taking a snapshot of your target device while it is in a clean state. This way, 
you can quickly revert to the snapshot if necessary. To do this, right-click the HP OVCM 
Target Device tab and select Take Snapshot. Type a name such as Initial Target 
Image and click OK. It may take a few minutes for the snapshot to be completed.  

Now, you have your virtual environment and can begin installing the HP OpenView Configuration 
Management Solutions.
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5 Installing the HP OpenView 

Configuration Management Solutions 

Software 

This chapter describes how to install and configure the HP OpenView Configuration Management 
Solutions software on your virtual server machine. 

Figure 17 below provides an overview of what you will install in this demonstration environment. 

Figure 17 Installation and configuration flow used in demo environment 

 

About the installation media and tools 

The HP OpenView Concepts and Processes DVD contains everything you need to complete the 
instructions in this document. Below is a description of the folders and their contents. 

 
Note that there are additional files and directories for other platforms and products that will 
not be used. 

Be sure to use only the media specified in this guide. 

Commented [TES2]: Would anyone like to see a checklist so 
that you can refer to it if you haven’t finished the installation in 
one sitting? 
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Table 9 HP OpenView Concepts and Processes DVD Contents 

Folder Contents 

\Applications_111705 Version 4.2 installation for the Radia Client 

\ConfigurationServer_11

1705\management_infrast

ructure 

Version 4.2 installations for: 

• HP OpenView Configuration Server Using Radia 

• HP OpenView Administrator Workstation Using Radia  

• HP OpenView Extensions for Windows Installer Using 
Radia 

\Infra_111705\extended_

infrastructure 

Version 4.2 installations for: 

• HP OpenView Knowledge Base Manager Using Radia 

• HP OpenView Management Portal Using Radia  

• HP OpenView Proxy Server Using Radia 

\Infra_111705\managemen

t_extensions 

Version 4.2 installation for the HP OpenView Policy Server 
Using Radia. 

\Licenses_and_Serial_Nu

mbers  
• Radia RUP.txt contains the license string for the HP 

OpenView Extensions for Windows Installer Using 
Radia, HP OpenView Usage Manager Using Radia and 
Patch Manager. 

• RADIA v3+.nvd is the license file used for all other 
HP OpenView Products used in this document 

\Patch_prerequisite_sof

tware\extended 

infrastructure\messagin

g_server 

Installation for HP OpenView Messaging Server 3.2 Using 
Radia 

\Patch_prerequisite_sof

tware\extended 

infrastructure\reportin

g_server 

Installation for HP OpenView Reporting Server 3.2 Using Radia 

\Patch_prerequisite_sof

tware\Radia Self 

Maintenance 

Update to nvdkit.exe for the Radia client to the 8.4 tcl version 

\Patch_prerequisite_sof

tware\Management_Portal

_2.1_Updates 

• The Tcl 8.4 metakit conversion utility  

• HP OpenView Management Portal Using Radia updates. 

\PatchMgr_3.0\ 
Extended_infrastructure

\patch_manager_server 

Installation for HP OpenView Patch Manager 3.0 Using Radia  

\PatchMgr_3.0\ 
local_patches 

The patches that you will use in the exercises for patch 
acquisition. 

\Publications CD Comprehensive documentation about all of the products 
covered in this guide. For new documents and updated 
versions, go to 
http://ovweb.external.hp.com/lpe/doc_serv/ 

\Resources Miscellaneous resources that you will need while using this 
document. 

http://ovweb.external.hp.com/lpe/doc_serv/
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Folder Contents 

\UsageManager Installation for HP OpenView Usage Manager Using Radia.  

\VMware_images\HP OVCM 

Server 

A compressed VMware image of a server with the following: 

• Windows 2003 Server Enterprise Edition SP1 

• Microsoft’s SQL Server 2000 and Service Pack 4 

• 1 GB  of memory 

• 16 GB free disk space 

• Internet Information Services (IIS)  

• Active Directory 

• DHCP  

• DNS Server 

• VMware tools 

\VMware_images\ HP OVCM 
Target 

A compressed VMware image of a target machine with 
Windows XP with Service Pack 2. 

Before You Begin 

• If necessary, create Shared folders so that you can access information on your host machine. To 
do this, see Configuring Shared Folders in VMware on page 126. 

• Copy the \Licenses_and_Serial_Numbers folder to the server desktop. 

• Be sure that you are comfortable using VMware. 

— Remember that you have to click in an image to make it active.  

— To release your cursor, press CTRL + ALT on your keyboard. 

— To reboot or shutdown the machine, press CTRL + ALT + Insert on your keyboard. 

— Make sure you understand how to take snapshots and how to use the Snapshot Manager. We 
recommend that you take snapshots of your work along the way so that if necessary, you can 
return to an earlier snapshot, rather than going back to the initial image. This is also helpful 
when performing the exercises because it will allow you to perform them more than once by 
returning to an earlier snapshot. 

• Whenever instructed to perform a manual exercise, such as typing information into fields, be 
very careful. A typo can affect the outcome of your installation. 

Reference Guide for the Environment 

Use the following table as reference for information that will be provided throughout this document. 
This table contains user ids, passwords, IP addresses and more. 

General Setup 

Table 10 General 

Item Value 

Domain Demo.hp.com 

Commented [TES3]: Could use better title 

Commented [TES4]: WWhat do people think? Is this useful? 
Or, would it be better later – so that people don’t try to build 
things on their own with this limited info? Or, is it even 
necessary? 
 
Someone suggested:  How about putting each of these tables in 
their respective sections? Use “Setup” in the name of the table.  
This way the user hopefully won’t try to skip steps and install by 
themselves. 
 
My response is that I think we should either remove it or make it 
an appendix. I want to hear your thoughts. 
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Item Value 

Pre-defined users with their 
organizational units, user ids and 
passwords 

Lisa Black  

• ou = Corporate 

• ou = Engineering  

• uid = LBlack  

• pw = HPOV#0123 

Mark Smith  

• ou = Corporate 

• ou = Engineering  

• uid = MSmith  

• pw = HPOV#0123 

Jessica Putnam  

• ou = Corporate 

• ou = Marketing 

• uid = JPutnam  

• pw = HPOV#0123 

Larry Linzer 

• ou =Corporate 

• ou = Marketing  

• uid = LLinzer  

• pw = HPOV#0123 

 

Table 11 HPOV Config Mgmt Server 

Item Value 

Administrator User Name Administrator 

Administrator Password radia 

Server IP 192.168.5.40 

SUBNET Mask 255.255.255.0 

Hostname HPOVSERVER 

Default Gateway 192.168.5.2 

Preferred DNS Server 127.0.0.1 
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Table 12 HP OVCM Target Device  

Item Value 

Administrator User Name Administrator 

Administrator Password radia 

IP 192.168.5.10 

Subnet mask 255.255.255.0 

Default Gateway 192.168.5.2 

Preferred DNS Server 192.168.5.40 

hostname hpovclient 

 

Table 13 SQL Server  

Item Value 

SQL administrator name   sa 

SQL administrator password radia 

Inventory Manager Database Name Inventory 

Patch Manager Database Name Patch 

Usage Manager Database Name Usage 

ODBC DSN Name for Inventory Database Inventory 

ODBC DSN Name for Patch Database Patch 

ODBC DSN Name for Usage Database Usage 

 

 

Table 14 HP OpenView Configuration Server Using Radia  

Item Value 

Configuration Server Name RCS 

Configuration Server ID 001 

Zone Name Demo 
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Table 15 Proxy Server  

Item Value 

RPS User ID RPS 

 

Table 16 Management Portal  

Item Value 

User Id admin 

Password secret 

Management Portal Zone Name Demo 

Zone Friendly Name Demo 

Creating and Configuring SQL Databases 

Several of the HP OpenView Configuration Management Products use a structured query language 
(SQL or Oracle) database via ODBC.  These databases store information that you can view through 
the HP OpenView Reporting Server Using Radia. For this installation, you will use SQL Server only. 

You must create the databases and create the ODBC connections to the databases prior to installing 
the products.  You will also perform administrative tasks for allocating space and creating user IDs 
and passwords for the Databases. 

Repeat the following steps three times in order to create three databases⎯Inventory, Patch, and 
Usage. 

To create the databases 

1 On the HPOV Config Mgmt Server, go to  
Start→All Programs→Microsoft SQL Server→Enterprise Manager. 

2 Expand the tree on the left until you see the Databases folder. 
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3 Right click the Databases folder and select New Database. 

The Database Properties window opens. 

4 In the Name text box, type Inventory. 

 
Each time you repeat these steps give the database a new name – Patch and Usage. 

5 Select the Data Files tab. 

6 In the Initial size (MB) field, type 50.  

7 In the File Properties area, confirm that the Automatically grow file check box is selected. 
Select by percent and type 20. 

8 Select the Transaction Log tab. 

9 In the Initial size (MB) field, type 25.  

10 In the File Properties area, confirm that the Automatically grow file check box is selected. 
Select by percent and type 20. 

11 Click OK. 

15 Repeat these steps two more times, changing the value that you enter in the Name text box to 
Patch and Usage. 

16 When you are done, close the SQL Server Enterprise Manager. 

When you have created the three databases, you will create ODBC system connections to the SQL 
Databases.  

To create ODBC System Connections to the SQL Databases 

You must create ODBC system connections in order to post data to your SQL Databases.  

1 Go to Start→ Administrative Tools→Data Sources (ODBC). 

2 In the Data Source Administrator dialog box, select the System DSN tab. 

3 Click Add. 

4 In the Create New Data Source dialog box, select SQL Server.  
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5 Click Finish. 

6 When creating an ODBC System Connection to the Inventory Database, in the Create a New Data 
Source to SQL Server dialog box, type Inventory for the name and description for the data 

sources. 

 
You will repeat these steps two more times. Each time, type a new name and 
description – Patch and Usage. 

7 From the Server drop-down list box, select the name of the server, HPOVSERVER.  

8 Click Next. 

9 For How should SQL Server verify the authenticity of the login ID? select With SQL Server 
authentication using a login ID and password entered by the user. 

10 In the Login ID text box type sa, and in the Password text box type radia for the SQL server 
authentication.  

11 Click Next. 

12 Select the Change the default database to check box and then select the appropriate database for 
the connection you are creating. For example, if you are creating a connection for the Inventory 
database, select Inventory. 
 

13 Click Next. 

14 Leave the default settings and click Finish. 

15 In the ODBC Microsoft SQL Server Setup dialog box, click Test Data Source to test your 
data source connectivity. 

16 When the test has completed successfully, click OK until you return to the System DSN tab in the 
ODBC Data Source Administrator.  

 
In the rare event that this test fails, your SQL service may have stopped or become 
unavailable before testing the data source. To check whether your SQL service is running, 
go to Start→All Programs→Microsoft SQL Server→Service Manager. If the service is 
stopped or paused, click Start/Continue and then retry the data source test. 

17 Click OK. 

18 Repeat these steps (from step 3) two more times, changing the value that you use for the name 
and description to Patch and Usage. 

19 After you have created all of the connections, click OK in the ODBC Data Source Administrator 
dialog box. 

Installing the HP OpenView Configuration Server Using 

Radia  

The HP OpenView Configuration Server Using Radia resides on a single server, or several can be 
installed across a network. The Configuration Server installation also contains the Radia Database. To 
view or manipulate the contents of the Database, you must use the Management Portal or the System 
Explorer. 

In this demo, you will install the Configuration Server on a single server. Use these instructions for 
the installation.  
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Leave the defaults unless noted otherwise in the instructions below. 

 

To install the HP OpenView Configuration Server Using Radia 

1 From the HP OpenView Concepts and Processes DVD go to 
\ConfigurationServer_111705\management_infrastructure\configuration_

server\win32 and double-click setup.exe. 

2 On the select products to be installed and supported window, select the Patch Manager and 
Usage Manager check boxes. 

3 On the License Information window, browse to \Licenses_and_Serial_Numbers and 
select RADIA v3+.nvd. 

4 In the Specify the Zone Name text box, type Demo. The Zone Name is a label for the group of 
intended target devices.  

5 Click Install. 

6 Click Finish. 

Updating the HP OpenView Configuration Server Using Radia 

You must update the HP OpenView Configuration Server Using Radia so that you have the latest 
version which supports the Messaging Server. 

To update the HP OpenView Configuration Server Using Radia 

1 From the HP OpenView Concepts and Processes DVD go to 
\ConfigurationServer_111705\management_infrastructure\configuration_

server\migrate_rcs.  

2 Copy the file ZTASKEND (dated 8/10/2005) and paste it into 
C:\Novadigm\ConfigurationServer\rexx. 

3 Open C:\Novadigm\rexx\Novadigm and rename ZTASKEND to OLDZTASKEND. 

Next, you must copy a new taskend.tcl to support Radia Reporting. 

To apply the taskend.tcl file to your Configuration Server 

1 Stop the Configuration Server Service. 

2 Go to Start→ Administrative Tools→Services. 

3 Select Radia Configuration Server, right-click and select Stop. 

4 Go to C:\Novadigm\ConfigurationServer\Lib\taskend.tcl and rename it to 
taskend.old. 

5 From the DVD, go to \Patch_prerequisite_software\extended_infrastructure 
\reporting_server\win32\media\PreReq\RCS\LIB and copy taskend.tcl. 

6 Paste this file into C:\Novadigm\ConfigurationServer\Lib. 

7 Start the Configuration Server Service. 

a Go to Start→Administrative Tools→Services. 

b Select Radia Configuration Server, right-click and select Start. 
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Installing and Configuring the Administrator Workstation 

The Administrator Workstation contains a set of tools for basic administrative functions such as 
managing the Radia Database, preparing applications, and viewing client objects. 

Use these instructions to install the Administrator Workstation.  

 
Leave the defaults unless noted otherwise in the instructions below. 

 

To install the Administrator Workstation 

1 From the HP OpenView Concepts and Processes DVD, go to 
\ConfigurationServer_111705\management_infrastructure\administrator_

workstation\win32 and double-click setup.exe. 

2 On the IP address and port window, type the IP address, 192.168.5.40, for the Configuration 
Server. 

3 Once the installation is complete, go to Start→All Programs→Radia Administrator 
Workstation→Radia System Explorer to open the System Explorer. 

4 In the User ID text box, type RAD_MAST and leave the password text box blank. 

5 In the System Explorer, go to View→Options and set the options as follows.  

 
See HP OpenView Administrator Workstation Using Radia: System Explorer Guide for 
more information about these options.  

For this demo, use the recommended settings; otherwise your view of the System 
Explorer may be different from what is shown in this document. 

a On the General tab, select the Show Class Names Next to Descriptions check box as shown in 
the figure below. Leave the rest of the default settings. 

 

b On the Instance Options tab: 

– Clear the check boxes for Before Instance Updates, Before Connections are Made and 
After Successful Connections. 



Installing the HP OpenView Configuration Management Solutions Software 55 

– In the When Displaying Instance Attributes, Show Attribute, select Both. 

– Select the Highlight _BASE_ inherited variables with an Underbar check box. 

 

c On the Advanced tab, select the Show Add Edit and Replace options for File type 
components check box as shown below. 

 

8 Click OK 

9 From the View menu, select List View→Details. 

10 From the View menu, select Tree Icons→Small. 

11 Close the System Explorer. 
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Performing Radia Self Maintenance 

You must use the supplied Client Self-Maintenance package to automate the distribution of an 
updated nvdkit.exe (which uses Tcl 8.4 for its performance improvements).   

To import the client self maintenance package 

1 From the HP OpenView Concepts and Processes DVD go to \Patch_prerequisite 
_software\Radia_Self_Maintenance\4.x and copy the files to C:\Novadigm 
\ConfigurationServer\Bin. 

2 Go to Start→Administrative Tools→Services. 

3 Go to the Radia Configuration Server service, right-click it and select Stop. 

4 Go to command prompt and change the directory C:\Novadigm 
\ConfigurationServer\Bin. 

5 Type the following: 

Zedmams zfile import.txt 

A return code of 0 or 4 is successful. 

6 Exit the command window. 

7 Go to Start→Administrative Tools→Services. 

8 Go to the Radia Configuration Server service, right-click it and select Start. 

Updating the HP OpenView System Explorer Using Radia 

You must perform this update for your HP OpenView System Explorer Using Radia to work properly. 

1 From the DVD, go to \resources and copy R3207241.zip to your machine. 

2 Extract the file to C:\Program Files\Novadigm. 

Installing and Configuring the HP OpenView Patch 

Manager Using Radia 

HP OpenView Patch Manager Using Radia provides an administrator with the ability to configure 
acquisition tools to automatically collect security patches from a vendor’s web-based security patch 
repository.  In addition, Patch Manager can perform impact analysis and pilot testing to identify 
affected applications and devices. 

Use these instructions to install HP OpenView Patch Manager Using Radia 3.0.  

 
Leave the defaults unless noted otherwise in the instructions below. 

 

To install the HP OpenView Patch Manager Using Radia 

1 From the HP OpenView Processes and Concepts DVD, go to 
\PatchMgr_3.0\extended_infrastructure\patch_manager_server\win32. 

2 Double-click setup.exe. 
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3 For Select Components to Install, select all of the check boxes. 

4 Go to \Licenses_and_Serial_Numbers\RADIA v3+.nvd, select the file and click Open. 

5 Specify the Integration Server IP address 192.168.5.40. 

6 Accept the rest of the defaults and click Install. 

 
The installation may seem to stall at 44%. However, it will continue after a short wait. 

7 When asked if you want to delete the existing PATCH domain, click Yes. 

8 When asked if you want to open a web browser to finish the configuration, click Yes. The URL 
for the web page is http://192.168.5.40:3466/patch/manage/admin.tsp. 

 

 

9 On the left, in the Configuration area, click All Settings. 

10 Enter the following information: 

a In the Configuration Server area, type RAD_MAST in the User ID text box.  

b In the ODBC DSN area; in the Name text box, type Patch and the password, radia. 

c In the Patch Agent Updates area, make sure that the following are selected – Publish and 
Distribute, All, Version 3. 

d In the Reporting Server area, replace reportingserver with reporting. 

11 To save your changes, click Save. 

12 Click Apply configuration Changes Now and then click Apply. 

The page displays the date and time that the Patch Manager was started.  

13 Click Perform Database Synchronization Now and then click Submit. 
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You should view a Database Synchronization in progress message, including the start 
date and time. 

When done, you will see a final message that says Patch Manager started on MM-DD-YY 
HH:MM. 

Using the MoveRIS Utility (internal use only) 

The following procedure is a temporary internal solution to an issue where nvdkit.exe consumes 
100% of the server’s CPU. The issue is caused by co-locating Patch 3.0 (which uses tcl 8.4) on the 
same Integration Server instance using tcl 8.2. This issue can be resolved by running Patch 3.0 by 
itself on a separate Integration Server that utilizes the new nvdkit. To do this, you can use the 
MoveRIS utility. 

To use the MoveRIS utility 

1 From the DVD, Go to \resources\MoveRIS_1.2.4\ and copy MOVERIS.CMD and 
RISINDEX.CMD from \resources to C:\Novadigm. 

2 Open a command prompt and change the directory to C:\Novadigm. 

3 Type the following command: Moveris.cmd RPM and press Enter on your keyboard. 

This duplicates the RIS instance and configures it to run on the port, 3469.  

4 When Notepad opens and displays the module load lines, close Notepad to continue the move.  

5 When you are done, go to C:\Novadigm and delete MOVERIS.CMD and RISINDEX.CMD. 

6 Go to C:\Novadigm and you will notice a new directory called PatchManager_3469.  

7 Go to C:\Novadigm\PatchManager_3469\etc and use Notepad to open patch.cfg. 

8 Do a search for IntegrationServer and replace it with PatchManager_3469. You should make five 
replacements. The lines where the replacements should be made are listed below. 

DATA_DIR {C:\Novadigm\IntegrationServer\data} 

ETC C:/Novadigm/IntegrationServer/etc/patch 

HOME C:/Novadigm/IntegrationServer/modules/patch.tkd 

LOG C:/Novadigm/IntegrationServer/logs 

ROOT C:/Novadigm/IntegrationServer 

9 Save and close patch.cfg. 

10 Go to Start→ Administrative Tools→Services if you want to see the new Patch Manager 
Service. It is called Radia Integration Server (httpd-rpm) with a description of Patch Manager. 

11 To open the Patch Manager Administrator, go to http:://192.168.5.40:3469/patch 
/manage/admin.tsp. Add this page to your Favorites. 

 
If you receive an Internet Explorer message indicating that the content from the Web 
site is blocked, click Add. In the Trusted sites window, click Add and then click Close. 

Acquiring Patches 

Typically patches are acquired from the vendor and require Internet access. However, for this demo 
we do not have internet access and will use a pre-populated configuration.  

http://192.168.5.40:3469/patch/manage/admin.tsp
http://192.168.5.40:3469/patch/manage/admin.tsp
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To store patches locally 

1 In C:\Novadigm\PatchManager_3469, create a directory called data. 

2 From PatchMgr_3.0\local_patches, copy the \patch directory and the packing.list 
to C:\novadigm\PatchManager_3469\data\. 

Installing the HP OpenView Proxy Server Using Radia 

The HP OpenView Proxy Server enables Radia-managed devices to receive application data over the 
Local Area Network (LAN) instead of across a Wide Area Network (WAN). HP OpenView Proxy 
Servers increase scalability while dramatically reducing traffic over the network. The HP OpenView 
Proxy Servers used in your environment are beneficial if you have many target devices requesting 
the same resources from the same location. When data is cached on the HP OpenView Proxy Server, 
the demand placed on the HP OpenView Configuration Server is decreased, allowing the HP 
OpenView Configuration Server to allocate more resources to other tasks. 

Placing the HP OpenView Proxy Servers at strategic points in your network increases the efficiency at 
which data is transferred. The connection between subscribers and the HP OpenView Proxy Server 
may be more efficient than the connection between the subscribers and the HP OpenView 
Configuration Server. The factors that determine the efficiency of a connection between a server and 
a target device include hardware capability, network bandwidth, workload on the servers, network 
traffic patterns, and the volume of software to be distributed. 

 
For this demonstration, a Proxy Server isn’t truly necessary because we have a simple 
environment. However, since it is generally recommended to use Proxy Servers (because 
they can deliver data via HTTP) and to co-locate them if other Proxy Servers aren’t being 
used, we will install a co-located Proxy Server in order for you to gain the experience. 

A co-located proxy server is a Proxy Server placed on the same machine as the Configuration 
Server to provide a source for downloading resources to other HP OpenView Configuration 
Management Solutions using HTTP.  

Use these instructions to install the Proxy Server.  

 
Leave the defaults unless noted otherwise in the instructions below. 

To install the HP OpenView Proxy Server Using Radia 

1 From the HP OpenView Concepts and Processes DVD go to  
Infra_111705\extended_infrastructure\proxy_server\win32 and double-click 
setup.exe. 

2 On the License Information window, browse to \Licenses_and_Serial_Numbers and 
select RADIA v3+.nvd. 

3 In the Server IP address text box, type the server machine’s IP address, 192.168.5.40. 

4 Click Install and then click Finish. 

5 Because you are installing the Proxy Server on the same machine as the Configuration Server, 
you must configure the proxy as a co-located proxy. To do this: 

a  Use a text editor to open C:\novadigm\IntegrationServer\etc rps.cfg. 

b Change static-root to C:/Novadigm/ConfigurationServer/DB and the static-type 
attribute to server and as shown in the example below: 

-static-root  "C:/Novadigm/ConfigurationServer/DB" 
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-static-type  server  

 
Be sure to use forward slashes as shown in the example above. 

c Save and close the file. 

6 Restart the Radia Integration Server service. 

To restart the Radia Integration Server service 

1 Go to Start→ Administrative Tools→Services. 

2 Select Radia Integration Server (httpd), right-click and select Restart. 

Installing the HP OpenView Management Portal Using 

Radia 

The HP OpenView Management Portal Using Radia is a web-based interface that can be used to 
manage your HP OpenView Configuration Management infrastructure. Use these instructions to 
install the Management Portal.  

 
Leave the defaults unless noted otherwise in the instructions below. 

To install the HP OpenView Management Portal Using Radia 

1 From the HP OpenView Concepts and Processes DVD go to \Infra_111705\extended 
_infrastructure\management_portal\win32 and double-click setup.exe. 

2 In the Management Portal Zone Name text box, type Demo.  

3 In the Management Portal Zone Friendly Name text box, type Demo. 

4 When prompted, click Yes to allow Remotely Installable Infrastructure Components to be 
copied. 

5 When prompted, click Yes to allow Remotely Installable Client Components to be copied. 

6 When prompted for the location of these files, browse to the \Applications_111705 folder 
and click Next. 

7 When prompted, click Yes to install the Documentation. 

8 When you are prompted for the location of these files, browse to the \Publications CD 
folder and click Next. 

9 After you complete the Management Portal installation, a web page opens the Management 
Portal. Set this page as the default home page.   

To log into the Management Portal, the user id is admin and the password is secret. 

 
If you get a message about the content from the Web site being blocked, click Add. In 
the Trusted Sites dialog box, click Add and then Close. 

10 Close the web browser. 
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Configuring the Management Portal to access the Configuration 

Server 

You must add a new directory service to configure a connection between the Management Portal and 
the Configuration Server. 

To configure the Management Portal  

1 Open your Web browser. If you set the Management Portal as the default page, it will load 
automatically. If not, go to http://192.168.5.40:3466. In the User Name text box, type admin 

and in the Password text box, type secret. 

2 Click Login. 

3 In the workspace, click the ZONE: Demo icon, then click Configuration, and then click 
Directory Services. 

4 From the Model Administration task list, click Add Directory Service. 

5 In the Type list box, select ds-rcs. 

6 In the URL text box, change the value of localhost to the IP address of the Configuration Server 
which is 192.168.5.40. 

7 Click Submit. 

Now, you can see the classes stored in the Primary file of the Radia Database. 

 

 

 You may want to click  to create a shortcut in the Management Portal’s desktop to 
the Primary file. If you click this icon, you will be asked to confirm that you want to add 
a shortcut. Click the check mark to confirm. 

In the future, you will not have to navigate to Zone: Demo, Configuration to access this 
information. When you log into the Management Portal, Primary will be one of the 
items on the main desktop. 



62 Chapter 5 

Installing the HP OpenView Messaging Server Using 

Radia 

The Messaging Server is a service that is used with several of the HP OpenView Configuration 
Management infrastructure components. It continually monitors pre-defined locations on the server 
and routes data to external destinations. 

Use these instructions to install the Messaging Server 3.2. 

 
Leave the defaults unless noted otherwise in the instructions below. 

To install the Messaging Server 

1 Go to \Patch_prerequisite_software\extended_infrastructure 
\messaging_server\win32 and double-click setup.exe. 

2 On the Select each Data Delivery Agent (DDA) to Install dialog box, select all of the check boxes 
and click Next. 

3 For the RIM Server IP Address type the IP address 192.168.5.40 for the server. 

4 For the RIM Server Port, leave the default 3466. 

 
The RIM information must be entered even though we are not using the Inventory 
Manager. This is included for compatibility with existing installations of the Messaging 
Server. 

5 Leave the RMP IP Address and Port text boxes blank. 

6 Leave the default Store and Forward Port as 3461. 

7 On the RMS Configuration screens: 

a For the Data Source Name, type Patch. 

b For the Data Source User Name, type sa. 

c For the Data Source Password, type radia.  

8 On the Core Data Delivery Agent Configuration screens: 

a For the Data Source Name, type Inventory. 

b For the Data Source User Name, enter sa. 

c For the Data Source Password, enter radia. 

9 Type the RMP IP address 192.168.5.40. 

10 Type the RMP Port 3466. 

11 On the Inventory Data Delivery Agent Configuration screens: 

a For the Data Source Name, type Inventory. 

b For the Data Source User Name, type sa. 

c For the Data Source Password, type radia. 

12 On the WBEM Data Delivery Agent Configuration screens: 

a For the Data Source Name, type Inventory. 

b For the Data Source User Name, type sa. 



Installing the HP OpenView Configuration Management Solutions Software 63 

c For the Data Source Password, type radia. 

13 On the Patch Data Delivery Agent Configuration screens: 

a For the Data Source Name, type Patch. 

b For the Data Source User Name, type sa. 

c For the Data Source Password, type radia 

14 To install the Messaging Server, click Install. 

15 When the installation has completed, click Finish. 

16 Go to C:\novadigm\MessagingServer\etc. 

17 Use a text editor to open wbem.dda.cfg.  

18 Change the values of AUTOCREATE and STARTUPLOAD to 1. 

— AUTOCREATE enables the creation of a new SQL file and table entry for a new object class.  

— Setting STARTUPLOAD to 1 allows SQL tasks to be performed when the Messaging Server 
starts up.  

19 Save and close the file. 

20 Use a text editor to open core.dda.cfg. 

21 Change the value of STARTUPLOAD to 1. 

22 Save and close the file. 

23 Use a text editor to open inventory.dda.cfg.  

24 Change the value of STARTUPLOAD to 1. 

25 Save and close the file. 

26 Restart the Messaging Server service. 

a Go to Start→Administrative Tools→Services. 

b Select Radia Messaging Server, right-click and select Restart. 

Installing and Configuring the HP OpenView Policy 

Server Using Radia 

The HP OpenView Policy Server integrates with Microsoft’s Active Directory. The Policy Server is a 
Web server used for administration purposes such as mapping services to users in the directory tree. 
It provides integration and extended enterprise functionality with your directory services.  

Policy method connections in the Configuration Server Database are used to determine what services 
should be distributed and managed for the user that is currently logged on by querying the HP 
OpenView Policy Server. 

Modifying the Active Directory Schema 

The HP OpenView Policy Server integration with Microsoft’s Active Directory requires that certain 
attributes be added to the Directory schema.  A properly formatted LDIF file has been included on the 
DVD. 
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To modify the Active Directory Schema 

1 From the HP OpenView Concepts and Processes DVD go to \Resources and copy demo.ldif 
to your server machine. 

2 Go to a command prompt and change to the directory containing the demo.ldif file. 

3 Type the command ldifde –I –f demo.ldif and press Enter. 

The script runs and makes the necessary changes to your schema. You will be advised when the 
command has been completed successfully. 

Installing the HP OpenView Policy Server Using Radia  

Use these instructions to install the Policy Server. Leave all of the defaults. 

To install the Policy Server: 

1 From the HP OpenView Concepts and Processes DVD, go to Infra_111705 
\management_extensions\policy_server\win32 and double-click setup.exe. 

2 Click Install. 

 
If prompted, do not replace nvdkit with an older file. 

3 Click Finish. 

Configuring the HP OpenView Policy Server Using Radia for Active 

Directory 

Use the steps below to configure the Policy Server to communicate with Active Directory. 

To configure the Policy Server for Active Directory 

1 Open your Web browser. If you set the Management Portal as the default page, it will load 
automatically. If not, go to http://192.168.5.40:3466.  

2 In the top right banner area, click POLICY. 

3 Click Setup. 

The Setup/Configuration window opens. 

a Change Type to ldap. 

b In the LDIF text box, delete acme.ldif and leave this empty. 

c For Host, enter the IP address of the server machine 192.168.5.40. 

d In Base Dn type dc=demo,dc=hp,dc=com 

e In Bind Dn type administrator@demo.hp.com. 

f In the Bind Pw password, type radia. 

mailto:administrator@demo.hp.com
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4 To save your changes, click Submit. 

5 If the changes were accepted, you will see the following message: 

 

Configuring the HP OpenView Management Portal Using Radia for 

Active Directory 

You can use the HP OpenView Management Portal to mount and browse LDAP directories to be used 
for policy management. To do this, you must add a directory service for Active Directory in the 
Management Portal. 

To add a directory service for Active Directory 

1 Open your Web browser. If you set the Management Portal as the default page, it will load 
automatically. If not, go to http://192.168.5.40:3466. In the User Name text box, type admin 

and in the Password text box, type secret. 

2 Click Login. 

3 Click the ZONE: Demo icon, then click Configuration, and then click Directory Services.  

4 In the Model Administration task list (on the left), select Add Directory Service. 

5 Enter the Directory Services values as follows. 

a In the Common Name and Display Name text boxes, type AD_Demo. 

b In the Description text box, type AD Demo. 

c In the Type text box, select ds-ldap. 
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d In the URL text box, type ldap://192.168.5.40:389/administrator 
@demo.hp.com. 

e In the password text box, type the password for your Active Directory Server, radia.  

f In the Use text box, type dc=demo,dc=hp,dc=com. 

d To save the new configuration, click Submit. 

 You may want to click  to create a shortcut in the Management Portal’s desktop to 
the demo.hp.com domain. If you click this icon, you will be asked to confirm that you 
want to add a shortcut. Click the check mark to confirm. 

In the future, you can access the demo domain from the main desktop. 

6 In the navigation pane, click Desktop, 

7 In the workspace, click the Zone: DEMO icon, click Configuration, and then click Directory 
Services. 

8 In the workspace, click AD Demo and the properties window opens. 

9 From the Model Administration task list, select Modify. 

10 From the Used for Policy drop-down list, select true and click Modify. 

Configuring the LDAP Method 

Policy method connections in the Configuration Server Database are used to determine what services 
should be distributed and managed for the user or machine that is currently logged on by querying 
the HP OpenView Policy Server. 

In order to resolve both machine and user connects, you must create two LDAP methods in the 
Configuration Server Database and then connect the appropriate users to the LDAP methods. This 
prepares your Configuration Server Database to use LDAP for policy. 

To create the LDAP method in the Radia Database 

1 Go to Start→All Programs→Radia Administrator Workstation→Radia System Explorer. 

2 In the User ID text box, type RAD_MAST, leave the password text box blank and click OK. 

3 In the Database tree view, double-click PRIMARY and then POLICY. 

 
In later instructions, you may encounter instructions such as “Go to PRIMARY.POLICY”. 
This is a common way of instructing you to use the Database tree view and double-click 
each item. 

4 Right-click Users (USER) and select New Instance. 

The Create Instance dialog box opens. 

5 Type Machine_Connect for the Display name and SYSTEM for the instance name. The instance 
name must be SYSTEM because this allows the policy instance to be connected to the SYSTEM 
context. When a machine connects, it goes through the SYSTEM context to find its policy.  The 
Configuration Server takes this entry plus the machine name from the client and goes to the 
LDAP server to get the policy for that device. 

6 Click OK. 

7 Open the new instance by double-clicking Machine_ and then Machine_Connect. 
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8 In the right pane, double-click the _ALWAYS_ connection that has a value of 
POLICY.WORKGRP.DEFAULT. 

 

9 Modify the text in the Member of text box to POLICY.WORKGRP.DEFAULT-x. This comments 
out the use of internal policy so we can use Active Directory. 

10 Click OK. 

11 Go to PRIMARY.SYSTEM.ZMETHOD. 

 

12 Double-click ZMETHOD to open the class. Then, right-click ZMETHOD and create a new 
instance with the name LDAP_USER . 

13 Double-click LDAP_ and then double-click LDAP_USER.  

14 Double-click ZMTHPRMS. 

15 In the Parameters Passed to Method text box, type 
ldap:///dc=demo,dc=hp,dc=com??sub?samaccountname=<<LOCALUID>>. 

16 Click ZMTHTYPE, and select REXX 

17 Click ZMTHNAME, and in the member name of method text box, type nvdmtcl. 
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18 Click OK. 

You have finished creating the user method and must create the machine method. 

19 In the Database Tree View, right-click LDAP_USER, and select Copy Instance. 

20 In the Copy Instance LDAP_USER dialog box, type LDAP_MACHINE, and click OK. 

21 Double-click the LDAP_MACHINE instance, and double-click ZMTHPRMS. 

22 Change the Parameters Passed to Method to read as follows: 
ldap:///dc=demo,dc=hp,dc=com??sub?samaccountname=<<COMPNAME>>. 

23 Click OK. 

24 Go to PRIMARY.POLICY.USER.  

25 Right-click PRIMARY.POLICY.USER and select Refresh. 

26 Double-click the _NULL_INSTANCE_. 

27 In the right pane, double-click the _ALWAYS_ connection that has a value of 
POLICY.WORKGRP.DEFAULT. 

28 Modify the text in the Member of text box to POLICY.WORKGRP.DEFAULT-x. This comments 
out the use of internal policy so we can use Active Directory. 

29 Select the _ALWAYS_ Utility method and in the Utility Method text box, type 
SYSTEM.ZMETHOD.LDAP_USER. 
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30 Click OK. 

31 Go to PRIMARY.POLICY.USER, double-click MACHINE_ and then double-click 
MACHINE_CONNECT and change the Utility method to 
SYSTEM.ZMETHOD.LDAP_MACHINE. 

32 Click OK. 

When a user logs onto Radia, the Null instance calls the LDAP_USER method and determines the 
appropriate services for that user. When a machine connect occurs, the UID will be set to SYSTEM, by 
default, and the LDAP_MACHINE method is used to determine the appropriate services for the 
machine. 

Modifying the HP OpenView Configuration Server Using Radia 

In this section, you must update to the Configuration Server’s Database using the HP OpenView 
System Explorer Using Radia 

To update the Configuration Server 

1 Go to Start→All Programs→Radia Administrator Workstation→Radia System Explorer. 

2 In the User ID text box, type RAD_MAST, leave the password text box blank and click OK. 

3 Go to PRIMARY.SYSTEM.ZPRODUCT and double-click ZPRODUCT. 

4 Ctrl+click to edit the Novadigm, Patch, PatchMgr, and Software instances in the right pane. 
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5 Right-click and select Edit Multiple Instances. 

6 Look for the _ALWAYS_ connection that has a value of PRIMARY.POLICY.USER. 
&(ZMASTER.ZUSERID) and change it to PRIMARY.POLICY.USER.&(ZMASTER 

.LOCALUID). 

 

7 Click OK. When you get the Multiple Instance Edit Confirmation, click OK. 

8 Go to PRIMARY.SYSTEM.PROCESS.ZMASTER. 
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9 Double-click ZMASTER. 

10 In the right pane, double-click POLICY.USER.&(ZMASTER.ZUSERID) and change the value to  
SYSTEM.ZINTENT.&(SESSION.INTENT). 

11 Click OK. 

12 Close the System Explorer. 

Modifying the Configuration Server’s Profile  

The following must be done because your HP OpenView Configuration Server will use the HP 
OpenView Policy Server.  The EDMPROF file is the configuration file for the HP OpenView 
Configuration Server.  The following changes must be made to 
C:\Novadigm\ConfigurationServer\bin\edmprof.dat. 

To modify the Configuration Server’s Profile 

1 Go to Start→All Programs→HP Radia Configuration Server→Profile Editor. 

2 Locate the [MGR_POLICY] section and edit the following lines to read as follows. 

HTTP_HOST= 192.168.5.40 

HTTP_PORT = 3466 

3 Save and close the file. 

Installing HP OpenView Packager for Windows Using 

Radia  

Use the HP OpenView Packager for Windows Using Radia to package MSI files. Packaging is the 
process of identifying resources, editing the resources’ installation attributes, defining how they are 
installed and saving the resources and installation instructions. A package typically contains one or 
more files and configuration settings. 

Use these instructions to install the Packager for Windows. 

 
Leave the defaults unless noted otherwise in the instructions below. 
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To install the Packager for Windows 

1 From the HP OpenView Configuration Server DVD, go to \ConfigurationServer 
_111705\management_infrastructure\Radia_Ext_for_Win_Install\Installs

\Admin Components\Radia Packager for Windows Installer. 

2 Double-click Package.msi. 

3 Go to \Licenses_and_Serial_Numbers\Radia RUP.txt and copy the license string 
and paste it into the Enter the Product Serial Number text box. 

4 Clear the checkbox for Install Application Insight, Insulation, Windows Installer Advanced 
Features. 

5 Click Install. 

6 Click Finish. 

Installing and Configuring the HP OpenView 

Knowledge Base Manager Using Radia 

The HP OpenView Knowledge Base Manager Using Radia automatically scans specific directories for 
data and imports the data into the appropriate databases. 

Use these instructions to install the Knowledge Base Manager. 

 
Leave the defaults unless noted otherwise in the instructions below. 

To install the Knowledge Base Manager 

1 From the HP OpenView Concepts and Processes DVD, go to \UsageManager\Radia 
Knowledge Base Manager. 

2 Double-click Package.msi. 

3 When done, click Finish. 

Installing and Configuring HP OpenView Usage 

Manager Using Radia 

The HP OpenView Usage Manager Using Radia assesses patterns of application usage in your 
environment. This allows you to facilitate adherence to license agreements, re-provision licenses if 
needed, and monitor user productivity. 

Use these instructions to set up and install the HP OpenView Usage Manager Using Radia.  

 
Leave the defaults unless noted otherwise in the instructions below. 
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Modifying the HP OpenView Usage Manager Using Radia Database 

You must run several scripts to import the Usage Database schema information which accommodates 
the Reporting Server. 

To modify the Usage Database to accommodate the Reporting Server 

1 Go to Start→All Programs→Microsoft SQL Server→Enterprise Manager. 

2 From the Tools menu select SQL Query Analyzer. 

3 Confirm that the drop-down box in the toolbar displays the Usage database. 

 

4 From the File menu select Open. 

5 From within the Query Analyzer, open \UsageManager\SQL Server\SQL Server 2000 
on the DVD. 

6 Execute the SQL scripts in the following order:  

 
Use Query Execute or press F5 to run each script. 

a Step2_Define_UsageManager_Tables.sql 

b Step3_Define_Common_Tables.sql 

c Step4_Define_Views.sql 

d Step5_Define_Stored_Procedures.sql 

e Step6_Insert_Common_Functions.sql 

f Step7_Insert_Common_DefaultData.sql 

 
Do not exit the Query Analyzer. 

7 In the SQL Query Analyzer, open \UsageManager\SQL Server\SQL Server 
2000\ServicePacks\Required and execute SERVICEPACK13_RUM_SQL_SERVER 

2000.sql 

8 When you receive the message Query Batch Completed in the status bar, close the SQL Query 
Analyzer. 

Configuring the HP OpenView Usage Manager Using Radia Client 

The HP OpenView Usage Manager Using Radia client is installed through a pre-defined service in the 
Configuration Server Database that requires minimal configuration. Define inventory and collection 
parameters in this service and then distribute it to your target devices. 
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Setting the Usage Manager’s Serial Number 

You must set the Usage Manager’s serial number in the System Explorer in order to integrate Usage 
Manager with the HP OpenView Configuration Management infrastructure.  

To set the serial number 

1 Go to Start→All Programs→Radia Administrator Workstation→Radia System Explorer.  

2 Login as RAD_MAST with no password.  

3 Go to PRIMARY.USAGE.UMCONFIG.Configuration-Entire Enterprise and in the SERIAL 
attribute enter a valid serial number.  Note that this is the same license string from Radia 
RUP.txt. 

 

Setting the Collection Point 

In the following steps, you will define where data is sent after collection.  

To set the collection point 

1 Go to PRIMARY.USAGE.UMDESTPT.HTTP-RIS_ADDR. 

2 Double-click HTTP-RIS_ADDR and then double-click HTTP – RIS_IP_ADDR:Port\URL. 

3 Double-click COLLDEST and change the collection destination point as follows: 
http://192.168.5.40:3466/KB_Mgr1_Usage. 

http://192.168.1.10:3466/KB_Mgr1_Usage
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4 Click OK. 

Updating the Usage Manager Client 

You must perform the following updates to the Usage Manager Client. 

To update the Usage Manager Client 

1 Go to Start→All Programs→Radia Administrator Workstation→Radia System Explorer. 

2 Login with a User ID of RAD_MAST and a blank password. 

3 Click OK. 

4 Go to PRIMARY.USAGE.PACKAGE. 

5 Double-click Radia Usage Manager Client and then double-click the files icon for the client. 

 

6 Right-click Radia Usage Manager Client:UMSetup.exe and select Replace Component 
Data. 
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7 Go to \UsageManager\Client Install\Setup and select UMSetup.exe. 

8 Click Open. 

9 When asked to confirm, click Yes. 

10 Now, open Radia Usage Manager Client:UMSetup.exe. 

11 Confirm that the File Version is set to 3.1.0.78. 

 

12 Right-click Radia Usage Manager Client:UMCOLLCT.TCL and select Replace Component 
Data. 

13 Go to \UsageManager\Client Install\Scripts and select UMCollct.tcl. 

14 Click Open. 

15 When asked to confirm, click Yes. 

16 Right-click Radia Usage Manager Client:UMCONFIG.TCL and select Replace Component 
Data. 

17 Go to \UsageManager\Client Install\Scripts and select Umconfig.tcl. 

18 Click Open. 

19 When asked to confirm, click Yes. 

20 Right-click Radia Usage Manager Client:UMINVENT.TCL and select Replace Component 
Data. 

21 Go to \UsageManager\Client Install\Scripts and select uminvent.tcl. 

22 Click Open. 

23 When asked to confirm, click Yes. 

Installing the Usage Manager Administrator 

The Usage Manager Administrator installs a tool called the Rule Editor that is used by the Reporting 
Server to create Usage reports.  
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To install the Usage Manager Administrator 

1 From the HP OpenView Concepts and Processes DVD, go to UsageManager\Radia Usage 
Manager Administrator. 

2 Double-click Package.msi. 

3 Copy the license string from Radia RUP.txt into the Enter the Product Serial Number text 
box. 

4 Click Install and then Finish. 

Updating the HP OpenView Usage Manager Using Radia  

You must perform the following updates to the Usage Manager. 

To update the Usage Manager 

1 Copy \UsageManager\Radia Integration Server\etc\usage.cfg to 
C:\novadigm\IntegrationServer\etc. 

2 Use a text editor to open the usage.cfg file and change the DSN to “Usage” and the DSN_PASSWD, 
“radia”. 

3 Save and close the file. 

Configuring the HP OpenView Knowledge Base Manager Using 

Radia 

The final step in setting up the Usage Manager is to configure the Knowledge Base Manager so that it 
populates data into the Usage Manager Database. 

To configure the Knowledge Base Manager 

1 Go to Start→Control Panel→Radia KB Manager Configuration. 

2 At the top of the dialog box, click New. 

3 In the Knowledge Base Name text box, type Usage. 

4 From the Data Source Name drop-down list box, select Usage. 

5 Type sa for the username and radia for the password. 

6 Click OK. 

 
If you receive an error that the DataSource Name is already assigned to the Knowledge 
Base, click OK and Cancel. Then, click Save Configurations and try to add the new 
Knowledge Base again. 

7 Click New task. 

8 From the Task Type drop-down list box, select Radia Usage Manager Collection Files. 

9 In the Task name text box, type Usage Collection. 

10 Click Browse and go to C:\Novadigm\IntegrationServer\etc\usage\KB_MGR1 
_Usage. 

11 Click OK. 
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12 Click OK to close the Add Task dialog box. 

13 Click Save configurations… 

14 Click OK. 

15 Click Exit to close the Radia KB Configuration Manager. 

16 Restart the Radia KB Manager service. 

To restart the Radia Knowledge Base Manager service 

1 Go to Start→ Administrative Tools→Services. 

2 Click Radia Knowledge Base Manager, right-click and select Restart. 

Installing and Configuring the HP OpenView Reporting 

Server Using Radia 

The HP OpenView Reporting Server Using Radia interface provides a dynamic and intuitive way to 
use HP OpenView Configuration Management SQL data for reporting and overall environmental 
assessment. The web-based Reporting Server allows you to query the combined data in existing 
Inventory Manager, Patch Manager, and Usage Manager databases and create detailed reports. In 
addition, you have the option of mounting an existing LDAP directory, which allows you to filter your 
data using your LDAP directory levels. 

Use these instructions to install the HP OpenView Reporting Server Using Radia. 

 
Leave the defaults unless noted otherwise in the instructions below. 

To install and configure the Reporting Server 

1 From the HP OpenView Concepts and Processes DVD, go to 
\patch_prerequisite_software\extended_infrastructure\reporting_serve

r\win32. 

2 Run setup.exe. 

 
If you are asked to replace a .tcl file with an older version, click No. 

2 When done, click Finish. 

3 Go to Start→All Programs→Microsoft SQL Server→Enterprise Manager. 

4 From the Tools menu, select SQL Query Analyzer. 

3 Make sure Inventory is selected in the toolbar. 

4 From the File menu, select Open and go to C:\Novadigm\ReportingServer\prereq 
\SQL\RIM. 

5 Select the file and click Open. 

6 Press F5 on your keyboard to run the RIM PreReq Creation Script.sql. 

7 When the query batch is completed, select Patch in the toolbar. 

8 Go to C:\Novadigm\ReportingServer\prereq\SQL\RPM and run the RPM PreReq 
Creation Script.sql. 
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9 When the query batch is completed, select Usage in the toolbar. 

10 Go to C:\Novadigm\ReportingServer\prereq\SQL\RUM and run the RUM PreReq 
Creation Script.sql. 

11 Close the SQL Query Analyzer. 

Configuring Microsoft’s Internet Information Services (IIS) for 

Reporting 

The Microsoft IIS Web server hosts the HP OpenView Reporting Server Using Radia. Use these 
procedures to configure a .tcl extension in IIS for Radia Reporting, as well as create a Web share 

for easy access to the Reporting Server Web pages. 

To configure IIS for the Reporting Server .tcl extension and web sharing 

1 Go to Start→Administrative Tools→Internet Information Services (IIS) Manager. 

2 Go to Internet Information Services, HPOVSVR (local computer), Web Sites, Default Web 
Site. 

3 Right-click Default Web Site and select Properties. 

4 In the Default Web Site Properties dialog box, select the Home Directory tab. 

5 Click Configuration…. 

6 Click Add… and complete the entries as follows: 

a In the Executable text box, type C:\novadigm\reportingServer\bin 
\nvdkit.exe "%s" %s  

b In the Extension text box, type .tcl. 

c In the Verbs area, select Limit to: and type GET,HEAD,POST. 

d Select the Script Engine check box. 

e Select the Verify that file exists check box. 

 

f Click OK. 

5 Click OK until the dialog boxes are closed. 

To enable Web Sharing from the Root Directory for Reporting 

1 Go to C:\Novadigm\. 
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2 Right-click the Reporting Server folder and select Properties. 

3 Select the Web Sharing tab. 

4 Select Share the folder. 

5 In the Alias text box, type Reporting. 

6 Use the defaults for Access and Application permissions. 

7 Click OK. 

8 Click Apply and OK. 

Additional IIS Configuration for Windows 2003 Server 

You must perform some additional IIS configuration server steps when using Windows 2003 Server. 

To create the TCL CGI extension  

1 Go to Start→Administrative Tools→Internet Information Services (IIS) Manager. 

2 Select Web Service Extensions. 

3 In the right pane, click Add a new Web service extension.  

4 In the New Web Service Extension dialog box, type the Extension Name TCL CGI Extension. 

5 Click Add… 

6 In the Path to File text box, type C:\novadigm\reportingServer\bin\nvdkit.exe "%s" %s 

7 Click OK. 

 
If you receive the error “Environment variables in file names will not be expanded”, you 
can ignore the error and proceed. In this configuration we are defining nvdkit in a non-
standard way. The error is actually a warning that does not affect this because we do 
not need to expand the environment variables. 

8 Select the check box Set extension status to Allowed. 

9 Click OK. 

When the TCL CGI Extension is created, add a new MIME type to allow IIS to server the .tcl extension. 

To add a new MIME type for Windows Server 2003 

1 Go to Start→Settings→Control Panel→Administrative Tools→Internet Information 
Services (IIS) Manager. 

2 Right-click your IIS server, such as HPOV_SERVER (local computer) and select Properties. 

3 Click MIME Types…. 

4 Click New… and type the following information: 

a For Extension, type: .tcl 

b For MIME Type, enter: application/x-tcl. 

c Click OK. If this is already set, then simply continue. 

5 Click OK. 
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Allowing Anonymous Access 

The following procedure allows anyone who can access the Reporting Server web site the ability to 
review the reports.  

 
You would not do this in a production environment. 

To enable access to the Reporting Server without logging in 

1 Go to Start→Administrative Tools→Internet Information Services (IIS) Manager. 

2 Go to Internet Information Services, HPOV_SERVER (local computer), Web Sites, Default 
Web Site, Reporting. 

3 Right-click Reporting and select Properties. 

4 Select the Directory Security tab. 

5 In the Authentication and access control area, click Edit. 

6 Select the Enable anonymous access check box. 

7 In the user name text box, type administrator. 

8 In the password text box, type radia. When asked to confirm the password, type radia again.  

9 Click OK until you exit the dialog boxes. 

To allow full control to everyone 

1 Open Windows Explorer. 

2 Go to C:\Windows\. 

3 Right-click temp and select Properties. 

4 Select the Security tab. 

5 Click Add. 

6 In the Enter the object names to select text box, type Everyone. 

7 Click Check Names. 

8 Click OK. 

9 In the Permissions for Everyone area, select the Allow check box for Full Control. 

10 Click Apply and then OK. 

11 Go to C:\novadigm\reportingserver\log and delete reporting.log if it exists. 

Configuring the HP OpenView Reporting Server Using Radia  

The HP OpenView Reporting Server Using Radia configuration file, config.tcl, is located in 
C:\Novadigm\ReportingServer. This file includes settings such as the path where you installed 
the Reporting Server components, the ODBC DSN information and access credentials for each SQL 
database you are using, as well as LDAP Directory access root and credentials. Use this configuration 
to enable or disable specific report types, including usage and patch, and also to enable or disable 
individual features, such as caching. In this section, we will edit this file using the Web browser. 
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To set parameters in config.tcl 

1 Open a web browser and go to http://192.168.5.40/reporting/setup.tcl.  

2 Click OpenView Reporting Server Configuration. 

a Confirm that the Home Path is correct. 

b Confirm that Enable Default Reports is set to 1 (enabled). 

c Change the Date format to 0 (LOCAL). 

 

3 Click Inventory Manager Configuration. 

a Set Enable RAM Report Caching to 0. 

b Set Enable RIM Report Caching to 0. 

c In the RIM DSN text box, type Inventory. 

d In the RIM DSN Password text box, type radia. 

 

http://192.168.5.40/reporting/setup.tcl
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4 Click Patch Manager Configuration. 

b Set Enable RPM Reports to 1. 

c Set Enable RPM Report Caching to 0. 

e In the RPM DSN, type Patch. 

f In the RPM DSN Password text box, type radia. 

 

5 Click Usage Manager Configuration. 

a Set Enable RUM Reports to 1. 

b In the RUM Cache Lifetime, type 86400. 

c In the RUM DSN, type Usage. 

d In the RUM DSN Password text box, type the password. 

 

6 Click LDAP Configuration. 

a Set Enable LDAP to 1 

b In Enable LDAP Caching to 0. 

c In the LDAP Server Address, type the IP address for your Active Directory 
server⎯192.168.5.40. 

d In LDAP Base DN, type DC=DEMO,DC=HP,DC=COM. 



84 Chapter 5 

e In the LDAP User text box, type administrator@demo.hp.com. 

f In the LDAP Password text box, type radia. 

 

7 Click Radia Management Portal Configuration. 

8 In the RMP address text box, type 192.168.5.40. 

9 Click Apply. 

A file named config.new.tcl is created in C:\Novadigm\ReportingServer.   

10 Go to C:\Novadigm\ReportingServer. 

11 Rename the existing config.tcl. to config.old in order for the configuration changes to 
take effect. 

12 Rename config.new.tcl to config.tcl. 

13 If you would like to see the Reporting Server, open your Web browser and go to Open a web 
browser and go to http://192.168.5.40/reporting. Add this page to your Favorites. 

mailto:administrator@demo.hp.com
http://192.168.5.40/reporting
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Your HP OpenView Configuration Management Solutions installation is complete.
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6 Using the HP OpenView Configuration 

Management Solutions  

This chapter provides an introduction to the HP OpenView Configuration Management Solutions. At 
the end of each topic, a list highlights some additional tasks that can be done and references to 
additional information. Note that this list is not all-inclusive. It is important to recognize that this is 
simply an introduction to these solutions and is by no means comprehensive. 

Deploying Radia Clients to Target Devices 

Radia clients are agent-based applications that reside on target devices in your enterprise. They 
communicate with the HP OpenView Configuration Management servers to enable you to manage the 
discovery, deployment, configuration, repair, update and removal of content on devices. 

You can use the HP OpenView Management Portal Using Radia, a Web based interface, to deploy the 
Radia clients to the target devices in your enterprise. Before you can do this, you must add the target 
devices in your environment to the Management Portal directory. This can be done automatically 
through network discovery (when the Management Portal is in an NT domain) or manually using 
Management Portal tasks. Once the target devices are in the Management Portal directory, you can 
use the Management Portal to deploy the Radia Clients remotely. 

 
Your HPOV Config Mgmt Server should already be running.  

Be sure to also log on to your HP OVCM Target Device, with a User ID of administrator and 

password of radia in the DEMO domain.  

Adding a device 

In this task, your device will not be discovered through the network, so you must add it manually. 
Devices are always added to a group. In this task you will create a new group named Demo, and then 
add the Demo Target Machine to the Demo group. 

To add a device 

1 Go to the HPOV Config Mgmt Server machine. 

2 Open your web browser and type http://192.168.5.40:3466 in the address bar. 

3 Log into the Management Portal using the user id admin and the password secret. 

4 Click Login. 

5 In the workspace, click the Zone: Demo icon and then click Groups. 

6 From the Model Administration task list, click Add Group.  

7 In the Common Name and Display Name text boxes, type Demo. 

8 Click Add.  

9 From the Model Administration task list, click Add Device. 

10 In the Display Name text box, type HPOVClient. 

http://192.168.5.40:3466/
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14 In the DNS Host Name text box, type hpovclient. 

11 In the IP address text box, type 192.168.5.10. 

15 Click Submit. 

The device appears in the workspace. 

Deploying the Radia Clients to the Target Device 

Now that you have access to a target device, you can use the Management Portal to install the Radia 
Client. When you install the Radia Client for the first time, the Management Agent will also be 
automatically installed. The Management Agent allows the Management Portal to handle remote 
tasks. There are a number of Radia Clients.  In this demo, we will be installing all of them. 

To deploy the clients to the target device 

1 Go to the HOPV Config Mgmt Server machine. 

2 Use a text editor to open 
C:\novadigm\integrationserver\media\client\default\win32\install.ini. 

 

 
Confirm that the file is not set to read-only otherwise you will not be able to save your 
changes. 

 

3 Remove the semi-colon before the line that says the following: 

ADDLOCAL=NVDINSTALLRAM,NVDINSTALLRSM,NVDINSTALLRIM,NVDINSTALLPATCH,NVDI

NSTALLRLAE,NVDINSTALLROM,NVDINSTALLSVR 

This ensures that all of the Radia Clients are installed. 

4 Remove the semi-colon before ;resolutionmanager and set 
resolutionmanager=192.168.5.40. Resolutionmanager is the IP address of the 
Configuration Server. 

5 Remove the semi-colon before resolutionport and set resolutionport=3464. Resolutionport 
is the port of the Configuration Server. 

6 Save and close the file. 

7 Go back to the Management Portal and click HPOVClient. 

8 From the Operations task group, click Install Radia Client. 

9 In the Product area, leave all of the check boxes selected. 

10 In the RCS Host Name text box, leave the default setting to 192.168.5.40. This is the IP 
address that the Radia Client will use to access the Configuration Server. 

11 In the RCS Port number text box, leave the default setting to 3464. This is the port number that 
the Radia Client will use to access the Configuration Server. 

12 Select the Perform Silent Install? check box to install the clients without any user interface. 

13 Select the Perform Connect After Install? check box to have the target device connect to the 
Configuration Server after the installation. This allows the target device to register with the 
Configuration Server. 

14 In the User text box, type the administrator ID, administrator to obtain administrative 
authority on the target device's domain. 
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15  In the User Password text box, type the administrator password, radia to obtain administrative 
authority on the target device's domain. 

16 Click Next. 

17 Click Next again. 

18 Click Submit to initiate the installation immediately. 

The installation may take a while. You can watch the progress in the job status window. 

 

When the Client installation is complete, the following will be on your target device: 

• A shortcut to the Radia Software Manager 

• C:\Novadigm 

• C:\Program Files\Novadigm 

Once the Radia Client is installed, it is registered with the Configuration Server and is ready to be 
managed. 

On your server machine, go to the Management Portal and click on the HPOVCLIENT device and you 
will notice four new services have been installed. These are representations of the services that are 
running on the target device.  
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Additional Uses for the HP OpenView Management Portal Using 

Radia 

The above information is intended to introduce you to the HP OpenView Management Portal Using 
Radia. This component contains a great deal of functionality. Some additional things that you can use 
the Management Portal to do are: 

• Discover devices on your network that can be managed with the HP OpenView Configuration 
Management Solutions 

• Customize deployment settings, such as which products to deploy (e.g. Application Manager, 
Software Manager, Patch Manager, etc.) 

• Remotely distribute and administer OVCM infrastructure components such as Proxy Server 

• Set up multiple HP OpenView Configuration Management administrator accounts with different 
privileges and scope (role-based administration) 

• Configure policy assignments to manage software in your enterprise 

• Schedule and monitor jobs 

• Mount multiple directory services for device management 

Publishing Data 

In this section you will publish two sample MSI applications to the Radia Database; the first will be 
published as an optional service for use with the HP OpenView Software Manager Using Radia, and 
the second will be published as a mandatory service for use with the HP OpenView Application 
Manager Using Radia. 

Use the HP OpenView Publisher Using Radia to publish a package to the Radia Database. Once stored 
in the Database, the software packages are ready for distribution to your environment. 

To publish an MSI application as an optional service 

1 Go to the HPOV Config Mgmt Server machine. 

2 From the DVD, go to \Resources\Congrats\Product and copy the Software Congrats 
folder to C:\. 

3 Go to Start→All Programs→Radia Administrator Workstation→Radia Publisher. 

4 In the User ID text box, type rad_mast. 

5 Leave the Password text box blank. 

6 From the Type of data to publish drop-down list, confirm that Windows Installer is selected. 

7 Click OK. 

8 Go to C:\Software Congrats\WinNt\1.0.0\Package.Msi. The right pane displays 
information about the selected MSI file. 

9 In the Publish Mode section, leave the default setting, Advanced. 

10 Click Next. 

11 In the AIP location text box, type C:\temp\congrats. This is a temporary directory to store 
the package’s Administrative Install Point (AIP) in. 

12 Click Next.  
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13 The Welcome to the Software Congrats Setup Wizard opens.  

14 Follow the prompts to navigate through the wizard. 

15 In the Package Information section, perform the following tasks: 

a In the Name text box, type SWCONGRATS. 

b In the Display Name text box, type Software Congrats. 

c In the Domain text box, confirm that SOFTWARE is selected. 

d In the Description text box, type Software Congrats. 

e In the Release text box, type 1.0. 

16 Click Next. 

17 In the Service Information area, leave the default setting, Create new. 

18 In the Name text box, type SWCONGRATS. 

19 In the Display Name text box, type Software Congrats. 

20 In the Assignment type section, select optional. Optional services are only available if you are 
using the Software Manager client.  

21 In the Management type section, select Manual. This option means that you are responsible for 
managing your application through the Software Manager. In some cases, a company will 
configure their environment to do a nightly connect. Then, if this was set to Automatic, the 
applications that you installed using the Software Manager would be verified at that time. 

22 In the Report on the following events section, leave the default selections. 

23 Click Next. 

24 Review the Summary section to verify the package and service information you provided during 
the previous steps. When you are satisfied, click Publish. 

25 Click Finish when the publishing process is finished to exit the Publisher.  

The service is now ready for distribution to your enterprise.  

 
To keep your machine clean, go to C:\ and delete the Software Congrats folder. 

To publish an MSI application as a mandatory service 

1 Go to the HOPV Config Mgmt Server machine. 

2 From the DVD, go to \Resources\Congrats\Product and copy the Application 
Congrats folder to C:\. 

3 Go to Start→All Programs→Radia Administrator Workstation→Radia Publisher. 

4 In the User ID text box, type rad_mast. 

5 Leave the Password text box blank. 

6 From the Type of data to publish drop-down list, confirm that Windows Installer is selected. 

7 Click OK. 

8 Go to C:\Application Congrats\WinNT\1.0.0\Package.Msi. The right pane displays 
information about the selected file. 

9 In the Publish Mode section, leave the default setting, Advanced. 

10 Click Next. 
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11 In the AIP location text box, type C:\temp\congrats; this is a temporary directory to store 
the AIP in. 

12 Click Next.  

The Welcome to the Application Congrats Setup Wizard opens.  

13 Follow the prompts to navigate through the wizard. 

14 In the Package Information section, perform the following tasks: 

a In the Name text box, type APPCONGRATS. 

b In the Display Name text box, type Application Congrats. 

c In the Domain text box, confirm that SOFTWARE is selected. 

d In the Description text box, type Application Congrats. 

e In the Release text box, type 1.0. 

15 Click Next. 

16 In the Service Information area, leave the default setting, Create new. 

17 In the Name text box, type APPCONGRATS. 

18 In the Display Name text box, type Application Congrats. 

19 Click Next. 

20 Review the Summary section to verify the package and service information you provided during 
the previous steps. When you are satisfied, click Publish. 

21 Click Finish when the publishing process is finished to exit the Publisher.  

 
To keep your machine clean, go to C:\ and delete the Application Congrats 
folder. 

The service is now ready for distribution to your enterprise. If you want, you can use the 
Management Portal to view the new services. 

To view the new services 

1 In the Management Portal, click the ZONE: Demo icon, then click Configuration, and then click 
Primary. 

 
If Primary is not available, you may need to click the ZONE: Demo icon, then click 
Configuration, Directory Services, RCS Database and start the directory service. 

2 In the workspace, click Software. 

3 Click  in the workspace toolbar to go to the next page. 

4 Click Software Services. 

5 In the workspace, notice the new services, Application Congrats and Software Congrats. 
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If the applications do not appear in the workspace, click the Zone: Demo icon, 
Configuration, Managed Services Cache and click Refresh from the toolbar. Then, 
return to step 2 and continue to see the applications. 

Additional Uses for the Publisher 

The above information is intended to introduce you to the Publisher. All content that you wish to 
deploy with HP’s OpenView Configuration Management Solutions will first need to be published 
using the Publisher. The Publisher supports a wide variety of packages, including: 

• Operating system images 

• Content such as data files, documents, etc 

Managing Policy 

In this section, you will entitle and deploy the services that you just created. 

Entitling an Optional Service to a User 

In this section, you will entitle an optional service to a user. This service will be accessible to the user 
from the HP OpenView Software Manager Using Radia.  

To entitle the optional service to a user 

1 Go to the HPOV Config Mgmt Server machine. 

2 In the Management Portal, go to Directory→Demo. 

3 Click Corporate, Engineering, Lisa Black. 

4 From the Policy task group, click Modify Policies. 

5 In the workspace, click Software Management, and then click Software. 
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6 Select the check box for Software Congrats and click   in the Browse toolbar. 

 

7 Click Commit. 

You have now entitled the optional service to the user Lisa Black, making it available for management 
through the Software Manager on the target device. 

Using the HP OpenView Software Manager Using Radia 

Now that you have entitled an optional service to a user, you will switch roles from being the 
administrator and become the user. You will work on the target device and learn how to use the 
Software Manager to install and repair applications. 

To install the service 

1 Go to the HP OVCVM Target Device. 

2 Log in to the machine as LBlack with a password of HPOV#0123. 

3 From the desktop, double-click Radia Software Manager. 

4 On the Login screen, click OK. 

5 In the software catalog, select Software Congrats. 
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6 Click  to install the application. 

7 The application runs. In this case, the application is simply a message that says “Congratulations! 
You successfully installed this application using Software Manager.” 

8 Click OK. The Software Congrats shortcut appears on your desktop. If you double-click it, you 
will receive a the same message box. 

To repair the application 

Before you can repair this application, it must be broken. For the purposes of this demo, you are 
going to break the application. To do this, delete the desktop shortcut, Software Congrats, and then 
go to C:\Program Files\Software Congrats and delete Congrats.exe. 

1 If the Radia Software Manager is not running, double-click Radia Software Manager on the 
desktop. 

2 In the software catalog, select Software Congrats. 

3 Click  to verify the application. 

4 You will receive a message that indicates that verification errors have occurred.  

 

5 Click Show Details to see what has happened to your application. In this case, the application is 
missing a key file. 
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6 Click Repair. 

7 Notice that the shortcut appears on your desktop again and the service is listed as installed in the 
Software Catalog. 

8 Double-click Software Congrats on your desktop to see the application run again. 

9 Close the Software Manager. 

Entitling a Mandatory Service to a User 

In this section, you will return to the server machine and become the administrator again. You will 
entitle a mandatory service to a machine.  

To entitle the mandatory service to a machine 

1 Go to the HOPV Config Mgmt Server machine. 

2 In the Management Portal, go to Directory, demo, Computers. 

 

 
If necessary, you may need to click Desktop in the navigation pane so that you can click 
Directory in the workspace. 

 

3 Click HPOVCLIENT$. 

4 From the Policy task group, click Modify Policies. 

5 In the workspace, click Software Management and then click Software. 

6 Select the check box for Application Congrats and click  in the Browse toolbar. 

 

7 Click Commit. 
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Using the HP OpenView Application Manager Using Radia 

You have now entitled the mandatory service to the target device HPOVCLIENT, making it available 
for management through the HP OpenView Application Manager Using Radia.  There are many ways 
to manage applications using the Application Manager. In this exercise, you will notify the target 
device and the application will be installed. You can also configure the Application Manager to run 
periodically and detect policy changes and ensure that the target device is in compliance with current 
policy. Using Application Manager, you can manage software without user intervention. 

To notify the machine  

1 If you are not already on the HPOVCLIENT$ Computer Properties page, go to Directory, demo, 
Computers and click HPOVCLIENT$. 

2 From the Operations task group, click Notify. 

3 Confirm that the Notify type is set to Full Connect. 

4 Change the command line to read as follows: 

radskman dname=SOFTWARE,ip=192.168.5.40 

5 Click Next. 

6 In the Job Name text box, type Notify Target. 

7 Click Next. 

8 Click Submit. 

9 Go to the HP OVCM Target Device and double-click the OVCM system tray icon . A window 
opens showing you the progress of the connect.  

10 When the application is installed successfully, it runs. This is a simple application that displays a 
message box that says “Congratulations! You successfully installed this application using 
Application Manager.” 

11 Click OK. 

To run the service 

1 On the HP OVCM Target Device, double-click Application Congrats on the desktop. 

2 Click OK. 

 
If you would like to see the Application Manager repair an application, you can perform 
steps similar to what you did with the Software Manager. Remove some key files, then 
run the Notify again and the application will be repaired. 

Additional Uses for the Software Manager and Application Manager 

The above information is intended to introduce you to Policy Management and the Software Manager 
and Application Manager. These are key components used to distribute software with HP’s OpenView 
Configuration Management Solutions. Some operations they can be used for are: 

• Creating a self-service software catalog for users, allowing them to pick which applications to 
install and at what time and then verify, repair and remove them on demand. 

• Deploy, update, verify, repair and remove managed software without end-user intervention. 

• Defer software distributions. 

• Control bandwidth utilization. 
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Gathering Hardware and Software Inventory 

You can entitle inventory scans to target devices that have the HP OpenView Inventory Manager 
Using Radia client installed. After a scan is completed, you can view the results in the Reporting 
Server. 

In this section, you will first use the Management Portal to entitle a target device for an audit service, 
perform a notify to deploy the audit service, and then use the Reporting Server to view the 
information  

In the second set of exercises in this section, you will entitle the target device to a more detailed 
wbem scan to discover additional MSI-based software information. Then you will notify the device so 
it receives the audit service.  As before, the collected information is transferred to the Reporting 
Server for viewing. 

In both cases, the audit service runs immediately and transfers the inventory information back to the 
Configuration Server and Messaging Server. The Messaging Server posts the information to the 
Inventory Database, and then it is available for viewing from the Reporting Server. 

Performing a basic RIM Reporting Audit 

In this section, you will configure and run a basic Rim Reporting audit. The RIM Reporting audit 
discovers the device and provides basic information such as the IP address and installed operating 
system. 

Configuring the RIM Reporting Service  

In this section, you will use the Management Portal to modify the RIM Reporting Service. You will 
first set the inventory collection options to allow the RIM Reporting service to execute a differenced 
audit whenever a Radia managed-service is installed, verified, or updated. Then, you will make the 
service mandatory. 

To modify the Inventory collection options for the RIM Reporting service  

1 On the HPOV Config Mgmt machine, open the Management Portal and log in with the User Name 
admin and the password secret. 

2 Click the ZONE: Demo icon, then click Configuration, and then click Primary. 

3 In the workspace, go to Audit, Audit Services, RIM Reporting. 

4 In the RIM_Reporting Service Properties page, click Connections. Notice in the Inventory 
Options area, there is a current connection to "Differenced Audit on Install and Update". This 
means that an audit will be performed only upon initial installation of the service and during any 
updates. 

5 From the RCS Administration task group, click Add Component to Instance. 

6 On the Add Connections to RIM_Reporting page, from the Type drop-down list, select Other. 

7 From the Class drop-down list, select Inventory Options. 

8 From the Available Connections list, double-click Differenced Audit on Install, Verify and 
Update. This moves the entry to the Selected list. 

9 Click Next.  

10 Click Commit. 

11 In the RCS Administration task group, click Modify Instance. 
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12 From the Mandatory or Optional drop down list box, select M. 

13 Click Modify. 

Entitling the Target Device to the RIM Reporting Service 

Now, you will use the Management Portal to assign policy through Active Directory. Specifically, you 
will entitle the target device to the RIM Reporting audit service.  

To entitle the target device the RIM Reporting audit service 

1 Go to the HPOV Config Mgmt Server machine. 

2 Open the Web browser and type http://localhost:3466 and log into the Management Portal 
using the user id admin and the password secret.  

3 Go to Directory, demo. 

 

 
If you need to restart the Directory Service for Active Directory, select demo, and from the 
Infrastructure task group select Start Directory Service. 

 

4 Go to Computers and click HPOVCLIENT$.  

5 From the Policy task group, click Modify Policies. 

The Workspace displays the Modify Policies dialog, where you will select the RIM Reporting 
service and add it to the target device’s policy. 

6 In the Browse area, click Software Management, then click Audit.  

7 Click the check box next to RIM Reporting. 

8 In the Browse area toolbar, click  to add the RIM Reporting service to the Policies list at the 
top of the page.  It will display as May (+) audit/rim_reporting. 

http://localhost:3466/
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9 Click Commit on the bottom of the page. 

You have now entitled the manadatory service, RIM Reporting, to the target device HPOVCLIENT. 
Next, you will notify the target device and the application will be installed and basic inventory 
information will be collected. 

Installing the RIM Reporting Audit Service 

To install the RIM Reporting audit service to your target device, use the Notify task from the 
Management Portal. 

1 Click HPOVCLIENT$. 

2 From the Operations task group, click Notify. 

3 On the Notify Opts page, set the Notify Type to Full Connect. 

4 In the Notify Information area, set the command line to  
radskman ip=192.168.5.40  

5 Leave the default port set to 3465. 

6 Remove any entries in the User and Password text boxes. 

7 Click Next. 

8 If you like, type a Job Name such as RIM Reporting. 

9 Click Next. 

10 Click Submit. 

If you want to see what is happening, you can go to the HP OVCM Target Device and double-click on 

the OVCM system tray icon . You will see the RIM Reporting service being installed. 
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Viewing the Results of the Inventory Collection 

Use the Reporting Server to view the results of the inventory collection. 

To view the results of the RIM Reporting inventory collection  

1 On the HPOV Config Mgmt Server, open a web browser and go to 
http://192.168.5.40/reporting/. 

2 On the Reporting Home Page, go to the Quick Search area for Inventory Information.  

3 In the Find a Device by Name text box type HPOV* and click Apply. 

The Managed Devices view opens, listing the device that matches the device name you just 
entered. In a typical environment you may have multiple listings that matched the search criteria 
above. 

 

4 To see the details for HPOVCLIENT, click  in the Details column.  

The Device Summary Report opens.  

5 To view a particular hardware report, such as Processor or Logical Drives, expand the report by 
clicking the + sign to the left of the title area. 

 

This is a simple report for a single device. If you had more devices, it would be useful to select and 
view other types of reports from the Reporting Views area on the left of the screen. For example, if 
you had collected Inventory data for many devices, you could view a report of Devices by 
Vendor/Model by selecting Inventory Management Reports, Hardware Reports, Detail 

Reports, and then Devices by Vendor/Model. 

http://127.0.0.1/reporting/
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Performing an NVDM Discovery of Applications  

In this section, you will configure and run an NVDM Discovery of Applications scan of the user’s 
computer to discover software applications installed on the target device. NVDM is an abbreviation 
for “Novadigm,” the company that created Radia, now known as the HP OpenView Configuration 
Management Solutions and was purchased by HP.   

Configuring the NVDM Discovery of Applications  

In this section, you will use the Management Portal to modify the NVDM Discovery of Applications 
Scan. You will first set the inventory collection options to allow the service to execute an audit that 
differences the audited information whenever a Radia managed-service is installed, verified, or 
updated. Then, you will make the service mandatory and finally, you will remove the default timer. 

To enable the NVDM Discovery of Applications Scan service to execute a differenced 

audit 

1 On the HPOV Config Mgmt machine, open the Management Portal and log in with the User Name 
admin and the password secret. 

2 Click the ZONE: Demo icon, then click Configuration, and then click Primary. 

 
If you do not see PRIMARY, you may need to click the ZONE: Demo icon, and then click 
Configuration, Directory Services, RCS Database. In the Infrastructure task group, click 
Start Directory Service. 

6 In the workspace, go to Audit, Audit Services, NVDM Discovery of Applications. 

7 In the NVDM Discovery of Applications Properties page, click Connections. Notice under the 
Inventory Options, there is a current connection to "Differenced Audit on Install and Update". 
This means that an audit will be performed only upon initial installation of the service and 
during any updates. 

8 From the RCS Administration task group, click Add Component to Instance. 

9 On the Add Connections to NVDM Discovery of Applications page, select a Type of Other, and 
select Inventory Options for the Class. 

10 From the Available Connections list, double-click Differenced Audit on Install, Verify and 
Update. This moves the entry to the Selected list. 

11 Click Next.  

12 Click Commit. 

13 In the RCS Administration task group, click Modify Instance. 

14 From the Mandatory or Optional drop down list box, select M. 

15 Click Modify. 

Entitling the Target Device to the audit service NVDM Discovery of 

Applications 

In this section, you will use the Management Portal to assign policy through Active Directory. 
Specifically, you will entitle the target device to NVDM Discovery of Applications service.  

To entitle the target device to the NVDM Discovery of Applications service 

1 Go to the HOPV Config Mgmt Server machine. 
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2 Log into the Management Portal using the user id admin and the password secret.  

3 Go to Directory, demo. 

 

 
If you need to restart the Directory Service for Active Directory, select demo, and from the 
Infrastructure task group select Start Directory Service. 

4 Go to Computers, HPOVCLIENT$.  

5 From the Policy task group, click Modify Policies. 

The Workspace displays the Modify Policies dialog, where you will select the MSI Based 
Applications service and add it to the target device’s policy. 

6 In the Browse area, click Software Management, and then click Audit.  

7 Click the check box next to NVDM Discovery of Applications. 

8 In the Browse area toolbar, click  to add the NVDM Discovery of Applications service to the 
Policies list.  It will display as May + audit/nvdm_discovery_of_applications. 

9 Click Commit on the bottom of the page. 

You have now entitled the manadatory service, NVDM Discovery of Applications, to the target device 
HPOVCLIENT. Next, you will notify the target device and the application will be installed and 
additional inventory information about applications will be collected. 

Installing the Audit for NVDM Discovery of Applications 

To install this NVDM Discovery of Applications service to your target device, use the Notify task from 
the Management Portal. 

1 Click HPOVCLIENT$. 

2 From the Operations task group, click Notify. 

3 On the Notify Opts page, set the Notify Type to Full Connect. 

4 In the Notify Information area, set the command line to  
radskman ip=192.168.5.40 

5 Leave the default port set to 3465. 

6 Remove any entries in the User and Password text boxes. 

7 Click Next. 

8 If you like, type a Job Name such as NVDM Discovery of Applications Reporting. 

9 Click Next. 

10 Click Submit. 

If you want to see what is happening, you can go to the HP OVCM Target Device and double-click the 

OVCM system tray icon . You will see the Application Discovery service being installed. 
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Viewing the Results of the Inventory Collection 

Use the Reporting Server to view the results of the inventory collection. 

To view the results of the inventory collection  

1 On the HPOV Config Mgmt Server, open a web browser and go to 
192.168.5.40/reportingserver/. 

2 On the Reporting Home Page, go to the Quick Search area for Inventory Information.  

3 In the Find a Device by Name text box type or HPOV* and click Apply. 

The Managed Devices view opens, listing the device that matches the device name you just 
entered. In a typical environment you will have multiple listings that matched the search criteria 
above. 

 

4 To see the details for HPOVCLIENT$, click  in the Details column.  

The Device Summary Report opens.  

http://127.0.0.1/reporting/
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5 To view a particular software report, click the + next to headings such as Windows System 
Services, Managed Services, Registered Application Scan, or Add/Remove Programs Scan. 
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Additional Uses for Inventory Collection 

The above information is intended to introduce you to the collecting and viewing of Inventory 
information. This component contains a great deal of functionality. Some additional things that you 
can do are: 

• Use the Audit Multi Files service to locate all  mp3 files on a target device and delete them or 
move them to another location.  

• Entitle different audits for different users or device characteristics. 

Managing Security Vulnerabilities with HP OpenView 

Patch Manager Using Radia 

Several software vendors, such as Microsoft, Sun, Red Hat, and HP, use Bulletins to announce when 
software patches for their products are available. In many cases, you can elect to have these Bulletins 
e-mailed to you to alert you to new security issues. These exercises illustrate how to use HP 
OpenView Patch Manager Using Radia to acquire and apply patches to the appropriate target devices 
to bring your Radia managed-devices into compliance as quickly as possible. Compliance means that 
the computer is not vulnerable to the security issue described in a bulletin or security advisory. 

To learn about Patch Manager, you will perform the following tasks: 

• Acquire patches and publish them to the Radia database 

• Use the Reporting Server to view acquisition reports. 

• Entitle and deploy the Discover Patches service to determine if a target device has any 
vulnerabilities. 

• Use the Reporting Server to view a compliance report by device.  

• Bring a vulnerable device into compliance by entitling it to the patch service and deploying the 
patch. 

 
For this demonstration, remember that you are running VMware in a host-only environment 
and do not have internet access. Therefore, you will acquire patches from a local folder that 
you prepared earlier, rather than Microsoft’s web site.  

Performing a Patch Acquisition 

You can create acquisition setting files that can be saved and used repeatedly. Once you create an 
acquisition file, you use the Patch Manager Administrator to run the acquisition using this file. 

In this exercise, you will create an acquisition settings file called MS06 and configure it to download 
Microsoft patches and the information about the patches. Then, you will use the Radia Patch 
Administrator to run the acquisition using this file. 

To create an acquisition settings file  

1 On the HPOV Config Mgmt Server, open a web browser and go to 
http://192.168.5.40:3469/patch/manage/admin.tsp.  

2 From Configuration, click Acquisition Settings. 

3 Click New to create a new file.  

http://192.168.5.40:3469/patch/manage/admin.tsp
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4 Type MS06 for the file name and Microsoft 2006 for the description, then click Next. 

5 In Bulletins type MS06* to get all bulletins that start with MS06. In this field you are searching 
for all Microsoft patches made available in 2006. This is Microsoft’s naming convention.  

6 In the Microsoft Setting Section, set Acquire Microsoft Patches? to Yes. 

7 Click Next. 

8 Click Finish to save the acquisition file you created. 

 

To run the acquisition 

1 From your web browser, go to http://192.168.5.40:3469/patch/manage/admin.tsp. 

2 From Operations, click Start an Acquisition. 

3 Click MS06 to select that acquisition file. 

4 Click Submit to start the acquisition.  

 
The acquisition may take approximately 20 minutes. 

When the acquisition is done, you will see a message indicating its success in the browser. A log file, 
patch-acquire.log is created in C:\Novadigm\IntegrationServer\log. 

Viewing Acquisition Reports 

Acquisition reports show the successes and failures of the patch acquisition process. You can use the 
Reporting Server to view web-based reports for the Patch Manager. 

To view the acquired bulletins from the Reporting Server 

1 From your web browser, go to http://192.168.5.40/reporting/. 

2 From Reporting Views, click Patch Management Reports and then click Acquisition 
Reports. 

3 Click Acquisition Summary to see the summary of all of your acquisitions. This includes the 
number of bulletins, patches and errors for each acquisition session. In addition it provides links 
to the acquisition reports for all bulletins and patches. 

 

4 Click on the number in the Bulletins column to see the bulletins that were requested as part of 
this acquisition.  

http://192.168.5.40:3469/patch/manage/admin.tsp
http://192.168.5.40/reporting/
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At the bottom, notice the exception report.  These are bulletins that were acquired but may not 
be supported by Patch Manager. If you review this report, you will notice that the Reason column 
may say “Currently not supported product” which means that these patches cannot be applied to 
the target device using Patch Manager. 

 

Entitling the Target Device to the Discover Patches Service 

Next, you will use the Management Portal to entitle the target device to the Discover Patches service. 
The Discover Patches service uses the data from the acquisition to scan the target device for 
vulnerabilities. Discover patches scans only for vulnerabilities to the patches that you acquired. 

To entitle the target device to the Discover Patches service 

1 Go to the HOPV Config Mgmt Server machine. 

2 Log into the Management Portal using the user id admin and the password secret.  

3 Go to Directory, demo. 

 

 
If you need to restart the Directory Service for Active Directory, select demo, and from the 
Infrastructure task group select Start Directory Service. 

 

4 Go to Computers, HPOVCLIENT$.  

5 From the Policy task group, click Modify Policies. 

6 Click Patch Management, and then click the check box next to Discover Patches.  
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7 In the Browse area toolbar, click  to add the Discover Patches service to the Policies list.  It 
will display as May + patchmgr/discover_patch. 

8 Click Commit on the bottom of the page. 

Installing the Discover Patches Service 

To install this Discover Patches service to your target device, use the Notify task from the 
Management Portal.  

1 Click HPOVCLIENT$. 

2 From the Operations task group, click Notify. 

3 On the Notify Opts page, set the Notify Type to Full Connect. 

4 In the Notify Information area, set the command line to  
radskman dname=PATCH,ip=192.168.5.40 

5 Leave the default port set to 3465. 

6 Remove any entries in the User and Password text boxes. 

7 Click Next. 

8 If you like, type a Job Name such as Discover Patches. 

9 Click Next. 

10 Click Submit. 

If you want to see what is happening, you can go to the HP OVCM Target Device and click on the 

OVCM system tray icon . You will notice that the client is scanning for Patch Vulnerabilities on the 
target device. 

 

Viewing Compliance Data 

Use the compliance report in the Reporting Server to identify which devices are vulnerable and need 
to have the acquired patches applied.  

To view the Compliance Report from the Reporting Server 

1 On the HPOV Config Mgmt Server, open your web browser and go to 
http://192.168.5.40/reporting. 
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2 From Reporting Views, click Patch Management Reports and then click Compliance 
Reports. 

3 Click Compliance by Devices to see the list of devices. 

4 In the Device column, click HPOVCLIENT to see the list of applicable patches. Note that this 
target device is vulnerable to MS06-001 through MS06-008. 

 

Deploying the MS06-005 Patch 

In this section, you will use the Management Portal to entitle the target device to the acquired patch 
service. Of the bulletins acquired, MS06-005 is one that the target device is both vulnerable to and is 
supported by Patch Manager.  If you return to your Acquisition report, you will see an Exception 
report at the bottom of the page.  Note that for some acquired bulletins, the “Reason” column states 
that the product to be patched is “currently not supported”.  

Entitling the target device to the MS06-005 Patch 

To entitle the target device to the new patch 

1 On the HOPV Config Mgmt Server machine, log into the Management Portal using the user id 
admin and the password secret.  

2 Go to Directory, demo. 

 
If you need to restart the Directory Service for Active Directory, select demo, and 
from the Infrastructure task group select Start Directory Service.  

3 Go to Computers, HPOVCLIENT$.  

4 From the Policy task group, click Modify Policies. 

5 Click Patch Management, then click the check box next to MS06-005.  

6 In the Browse area toolbar, click  to add the Discover Patches service to the Policies list.  It 
will display as May + patchmgr/ms06-005. 

7 Click Commit on the bottom of the page. 
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Installing the MS06-005 Patch 

To install this MS06-005 Patch service to your target device, use the Notify task from the 
Management Portal. By installing MS06-005, the target device is no longer vulnerable to this security 
issue. 

To install the MS06-05 patch 

1 Click HPOVCLIENT$. 

2 From the Operations task group, click Notify. 

3 On the Notify Opts page, set the Notify Type to Full Connect. 

4 In the Notify Information area, set the command line to  
radskman dname=PATCH,ip=192.168.5.40 

5 Leave the default port set to 3465. 

6 Remove any entries in the User and Password text boxes. 

7 Click Next. 

8 If you like, type a Job Name such as MS06-005 Patch. 

9 Click Next. 

10 Click Submit. 

If you want to see what is happening, you can go to the HP OVCM Target Device and click on the 

OVCM system tray icon .  You will see MS06-005 installed on the target device. 

To view that the device is in compliance with MS06-005 

1 From your web browser, go to http://192.168.5.40/reporting. 

2 From Reporting Views, click Patch Management Reports and then click Compliance 
Reports. 

3 Click Compliance by Devices to see the list of devices. 

4 In the Device column click HPOVCLIENT. Notice that the target device now has the MS06-005 
patch installed. 
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Tracking Application Usage with HP OpenView Usage 

Manager Using Radia 

The HP OpenView Usage Manager Using Radia tracks software usage across your enterprise. While 
the Inventory Manager also audits software, it only reports on the application status, not usage.  

In order to introduce you to the Usage Manager, you will perform the following tasks: 

• Configuring the Enterprise Collection service 

• Entitling the Enterprise Collection service 

• Installing the Enterprise Collection Service  

• Initiating Data Collection 

• Creating Usage Data to be collected 

• Viewing Reports 

Due to the limited number of target devices and data in this demonstration, you will be able to view 
only a small subset of data. This is not a typical use case scenario. 

Configuring the Enterprise Collection service 

In order to deploy the Client Install – Enterprise Collection service to the target device, it must be set 
to mandatory. This allows us to notify the target device and deploy the service without any user 
interaction. 

To configure the Enterprise Collection service 

1 On the HPOV Config Mgmt Server, open the Management Portal. Remember, the log in is admin 
and the password is secret. 

2 Click the ZONE: Demo icon, then click Configuration, and then click Primary. 

3 Click Usage. 

4 Click Application. 

5 Click Usage Mgr Client Install– Enterprise Collection. 

6 In the RCS Administration task group, click Modify Instance. 

7 From the Mandatory or Optional Service drop-down list box, change the selection to M. 

8 Click Modify. 

Entitling the Enterprise Collection service  

In this section, you will use the Management Portal to entitle the target device to the Client Install – 
Enterprise Collection service.  

To entitle the Client Install – Enterprise Collection service to the target device 

1 Go to the HPOV Config Mgmt Server machine. 

2 Log into the Management Portal using the user id admin and the password secret.  

3 Go to Directory, demo. 

 



Using the HP OpenView Configuration Management Solutions 113 

 
If you need to restart the Directory Service for Active Directory, select demo, and from the 
Infrastructure task group select Start Directory Service. 

 

4 Go to Computers, HPOVCLIENT$.  

5 From the Policy task group, click Modify Policies. 

6 In the Browse area, click Software Management, then click Usage.  

7 Click the check box next to Usage Mgr Client Install – Enterprise Collection. 

8 In the Browse area toolbar, click  to add the to Usage Mgr Client Install – Enterprise Collection 
service to the Policies list.  It will display as May + usage/client_install_enterprise. 

9 Click Commit on the bottom of the page. 

Installing the Enterprise Collection Service 

To install this Usage Mgr Client Install – Enterprise Collection service to your target device, use the 
Notify task from the Management Portal. 

 
By default, Usage information is collected on a weekly basis on Sundays at midnight. 

1 Click HPOVCLIENT$. 

2 From the Operations task group, click Notify. 

3 In the Notify Information area, set the command line to  
radskman dname=SOFTWARE,ip=192.168.5.40 

4 Leave the default port set to 3465. 

5 Remove any entries in the User and Password text boxes. 

6 Click Next. 

7 If you like, type a Job Name such as Usage Report. 

8 Click Next. 

9 Click Submit. 

If you want to see what is happening, you can go to the HP OVCM Target Device and click on the 

OVCM system tray icon .  You will see the Windows Installer client installation.  

Initiating Data Collection 

By default, data is scheduled to be collected on the first of the month and repeat once a week every 
Sunday at midnight.  

For this demonstration, you will force the collection of inventory and usage data. After the usage 
client is installed, two files, usdbinvn.exe and usdbcoll, are located on the target device in 
C:\Program Files\Novadigm\Application Extensions\Bin. 

Forcing collection of inventory data 

Rather than waiting for the scheduled collection, you can go to the target device to force an inventory 
collection. 



114 Chapter 6 

To force an inventory collection on the target device 

1 On the target device, go to Start→Run. 

2 In the Open text box, type C:\Program Files\Novadigm\Application 
Extensions\Bin\USDBINVN.exe and click OK. 

The inventory information is stored in the history.usdbase file in C:\Program 

Files\Novadigm\Usage Manager. 

Creating Usage Data to be collected 

Once the Collection service has been installed, double-click Software Congrats on the target device. 
This runs the application so that you have some usage data to be collected. 

Forcing collection of usage data 

To force usage collection on the target device 

1 On the target device, go to Start→Run. 

2 In the Open text box, type “C:\Program Files\Novadigm\Application 
Extensions\Bin\usdbcoll.exe” DatabaseName=Entire_Enterprise and click 
OK. 

This takes the active usage data and merges it into the history file and then reports it to the server. 

Viewing the Results  

Now, you can use the Reporting Server to view the results of your Usage Manager Collection. 

To view the results of the usage collection  

1 On the HPOV Config Mgmt Server, open a web browser and go to 
http://192.168.5.40/reporting/. 

2 In the Reporting Views group on the left, click Usage Manager Reports, Monthly Usage 
Reports, Product Reports and then click Monthly Usage by Product. 

http://127.0.0.1/reporting/


Using the HP OpenView Configuration Management Solutions 115 

 

Notice the list of products and the information about each of the products. We are going to focus 
on HP OVCM Demonstration which is the product name for the Software Congrats application. 

3 Click HP OVCM Demonstration. 

Here you can see the application name, which is installed and has been used. 

 

4 Click the + to the left of Usage Manager Devices. 

This displays all of the devices that have usage information for the HP OVCM Demonstration 
(Software Congrats) application. Again, since this is a demo environment and there is a single 
target device, you are unable to see how this is filtered. But, imagine you had 10 devices and only 
five had usage data for this application. The Usage Manager Devices report would list only those 
five devices. 

 

Additional Uses for Usage Manager 

The above information is intended to introduce you to the Usage Manager. The Usage Manager 
provides insight into the software being used in your environment. This information can be used to 
answer the following questions: 



116 Chapter 6 

• Are you using more licenses than you own? 

• Do you have software that was purchased and installed but remains unused? These licenses can 
be reclaimed and reused instead of purchasing new licenses.  
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Summary 

This document should have provided you with a good starting point for your journey to 
understanding the HP OpenView Configuration Management Solutions. You should be comfortable 
with: 

• Describing the products that you learned about in this guide. 

• Installing and configuring the solutions in this guide. Please remember that if you are using the 
solutions in any other environment, you must refer to the mainstream documentation for 
installation instructions and use the standard media. 

• Using the HP OpenView Configuration Management Solutions to complete basic tasks. 

Now that you have an introduction to some of the solutions, you can access additional resources to 
learn more. 
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7 Advanced Exercises 

This chapter is a follow on to the previous chapter. It contains an advanced exercise that you may 
choose to perform based on your comfort level with the solutions that you have learned about so far. 
If you feel very comfortable with the previous information, it is recommended that you proceed. If 
not, please review this document again or refer to the Related Documents on page 10 to expand your 
knowledge. 

Packaging and Publishing Windows Installer (MSI) 

Applications 

The Radia Packager for Windows Installer (WI) is a suite of components that give you the tools to 
easily create, modify, customize and manage Windows Installer Packages. 

In order to introduce you to the Radia Packager for Windows Installer, you will perform the following 
tasks: 

• Create an MSI package.  

• Modify the library. 

• Package the modified library. 

• Publish the package the Radia Database. 

For these exercises, you will use a sample application which includes the following files: 
Congrats.exe; Congrats.ini and a Desktop Shortcut that you will create. 

Currently, when Congrats.exe executes, it displays a simple message window using values set in 
Congrats.ini. This file reads as follows: 

[STRINGS] 

Title=AppTitle 

Message=AppMessage 

When Congrats.exe is run, the message window appears as follows. 

 

Creating an MSI Package 

First, you will use the Unified Package Creation Process of the Radia Packager for Windows Installer 
(WI) to create an MSI package for the Congrats.exe application.  The unified process builds a package 
in a single, streamlined session. It produces a state file containing the resources needed by the 
application. From this state file, the unified package creation process builds a library file and then 
uses the library to create the Windows Installer Package for the application. 
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To create an MSI package  

1 Create a folder C:\Program Files\Congrats\ on the HPOV Config Mgmt Server machine. 

2 From the DVD, copy \Resources\Congrats\Congrats.exe and Congrats.ini  to 
C:\Program Files\Congrats\.  

3 Create a shortcut to Congrats.exe on your desktop. 

4 On your desktop, double-click Radia Packager for WI. 

5 From the Radia Packager for Windows Installer wizard, select Unified package creation 
process. 

6 In the Select the Package Creation Method and Name section, do the following: 

a Select Resource Selection. This creates a package from a set of known resources. 

b Under Resource Selection, click Include related shortcuts. 

c In the Package Name text box, type CAP Software Congrats. 

d Click Next. 

7 On the Select Resources dialog box, set the filter as follows: 

a Go the Files resource and click the check box to clear any current selections. The check box 
for Files should now be a white box without any check mark. 

b Go to the Registry resource and click the check box to clear any current selections. 

c Expand the Files resource and browse to C:\Program Files\Congrats. 

d Select the check box to the left of Congrats. (This selects all of the files contained in the 
\Congrats directory.) 

8 Click Next.  

The Installation Analysis, State File and Library Analysis take place.  

9 On the Modify Library Installation Settings dialog box, click Next.  

10 In the Select the package creation mode area, leave the default Add to a New Product selected 
and click Next. 

11 On the Enter the Product Name, Version, Release and Build Numbers dialog box, leave the default 
settings.  

12 Click Next. 

13 In the Windows Installer Options dialog box, click Platform Requirements. 

14 In the Package Platform Requirements dialog box, clear the Only install if platform 
requirements are met check box and click OK. 

 
Since this application can run on any Windows platform, clearing this checkbox during 
the packaging process ensures us that Windows Installer will not prevent the package 
from being installed onto any Windows version. During the publishing process, you will 
select which Windows platforms to allow.       

15 Click Next. 

16 The Windows Installer package is created. When package creation is complete, click Finish.  

17 Go to C:\Program Files\Novadigm\AdvPub\Product\ 
CAP Software Congrats\WinNT\1.0.0 to view the contents of the package. You should 

see the following entries: 

— Package.Cab 
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— Package.IIState 

— Package.Msi 

— Setup.Exe 

— Setup.Ini 

Modifying the Library 

If you were to run the setup.exe file created above, the application would be installed and if you ran it 
you would see the following message: 

 

Instead of publishing the current package, you can modify the installation settings so that the Title 
and Message will be substituted with information entered by the user upon installation. This task 
demonstrates how to modify a library and define substitutions.  

In this exercise, you will replace the values of the title and message string in Congrats.ini with User 
Interface variables. The default values of the new variables will be: 

Title= Congratulations! 

Message= You successfully installed this application using Software 

Manager. 

Establishing these variables provides the user control over the final values that are distributed in the 
application to the target device.  

To define substitutions for the title and message strings  

1 On your desktop, double-click Radia Packager for WI. 

2 From the Radia Packager for Windows Installer wizard, select Refine Selected Components. 

3 Click Modify a Library and click Next. 

4 Click Modify Installation Settings and click Next. 

5 Select the Library named CAP Software Congrats and click Next. 

6 On the Modify Library Installation Settings dialog box, right-click Files and select 
Substitutions. 

7 Now, you will specify the Search/Replacement criteria used to substitute the Title string value 
with a new variable, AppTitle. The value for AppTitle will be entered during the installation.  

a From the Substitutions window, right-click Search/Replace criteria and select Add 
Search/Replace Criteria. 

b In the String text box, type AppTitle and click OK. 

c In the Replace search string with area, select Replacement Variable. 

d Click Add a Replacement Variable. 

e For the Variable type, click User Interface. User Interface variables automatically add dialog 
boxes to the installation process allowing users to enter values of their choice. 

f In the Name text box, type APPTITLE and click OK.  
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You must enter APPTITLE in all caps. 

g In the Variable Description Displayed by the User Interface text box, type a prompt for 
the user interface, such as: 

Enter a title for the application. 

h In the Default Value area, type the default value of Congratulations!  

i Click OK. 

j Click OK again to return to the Substitutions window.  

8 Now, you will specify the Search/Replacement criteria used to substitute the Message string 
value with a new variable, APPMESSAGE. The value for APPMESSAGE will be entered during the 
installation.  

a Right-click on Search/Replace Criteria and add the search string: AppMessage. 

b Click OK. 

c In the Replace search string with area, select Replacement Variable. 

d Click Add a Replacement Variable. 

e For the Variable type, click User Interface. 

f Type APPMESSAGE as the Name and click OK. You must enter this in all caps. 

g In the Variable Description Displayed by the User Interface text box, type a prompt for 
the user interface, such as: 

Enter a message to display when the application runs. 

h In the Default Value area, type a default value, such as: 

You successfully installed the application using Software 

Manager! 

i Click OK and OK again to return to the Substitutions window. 

9 Next, you must specify when the substitutions should apply. 

a Right-click the Search/Replace Criteria entry for AppTitle and select Find Search String. 

b In the Resource Name area, check the box next to the occurrence found within the ini file, 
and click OK. 

c Repeat steps a and b (above) for the search string AppMessage. 

10 Click OK to close the substitutions window. 

11 On the Modify Library Installation Settings dialog box, click Next. 

12 Click Finish. 

Packaging the modified library 

In this exercise, you will update the initial package with the modified library and also add a Custom 
Action EXE that will automatically run the Congrats application after it is installed. 

To update the package 

1 From the Radia Packager for Windows Installer menu, select Package Components. 

2 Click Modify a Package and click Next. 
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3 Click Rebuild a Package and click Next. 

4 Select the CAP Software Congrats product to modify, and click Next. 

5 Select the CAP Software Congrats package to modify, and click Next. 

6 Select the CAP Software Congrats library from which the package will be created, and click 
Next. 

7 In the Advanced Options dialog box, click Custom Actions. 

8 In the Set the Desired Custom Actions dialog box, you will create a custom action that will cause 
the application to run immediately after it is installed. To do this: 

a Right-click Executables and select Add an Executable. 

b In the Enter a description, type, and source for the new executable text box, type 
CongratsEXE. 

c For the Executable Type, select Exe. 

d Select Executable file is installed with the Package.   

e Click OK. 

f In the Executable File Name text box, leave the default location of the application as 
C:\Program Files\Congrats\Congrats.exe. 

g Click OK. 

9 In the Set the Desired Custom Actions dialog box, add an Installation Action that will run the 
application after installation.  

a Under Installation Actions, right-click on After Installation Actions, and select Add an 
Action. 

b In the Action Name text box type Runcongrats and confirm that CongratsEXE is 
selected as the executable to run. 

c Click OK. 

d In the Set the EXE Action Properties dialog box, leave the defaults and click OK. 

e Click OK again to exit the Set the Custom Actions dialog box. 

10 In the Advanced Options dialog box, click Next. 

11 When Package Analysis is complete, click Next, 

12 Review the Package results and click Next. 

13 Continue to click Next until the Package Creation dialog box opens. When the Package Creation is 
completed, click Next. 

14  Click Finish to exit the Packaging session. 

15 Close the Radia Packager. 

Publishing the Windows Installer Package  

Now that you have an MSI package for the CAP Software Congrats program, you can use the Radia 
Publisher to publish it to the Radia Database.  

 
Before beginning this publishing exercise, go to Start→All Programs→Control 
Panel→Add or Remove Programs to confirm that the CAP Software Congrats or Software 
Congrats applications are not currently installed on your machine. If either of these programs 
is installed, remove them before performing this exercise. 
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To publish the Windows Installer Package to the Radia Database 

1 Go to Start→All Programs→Radia Administrator Workstation→Radia Publisher. 

2 Complete the initial Radia Publisher dialog as follows: 

a Type a User ID of RAD_MAST. 

b Leave the password blank. 

c Leave the Type of data to publish set to Windows Installer. 

d  Click OK. 

3 Complete the Select window as follows: 

a Select the Windows Installer file to publish using the path and filename below: 

C:\Program Files\Novadigm\AdvPub\Product\CAP Software 

Congrats\WinNT\1.0.0\Package.msi 

b In the Publishing Mode area, leave the default mode of Advanced. 

c Click Next. 

4 Complete the Edit window as specified below: 

a Click Admin Install Point: 

– In the  AIP location text box, type C:\aip\CAP Software Congrats 

– Under the Execute user interface check box, click Basic. 

– Leave the rest of the default settings. 

b Click Installation Simulation. 

– Click Run User Interface to see the Windows Installer installation. This simulation 
allows you to select features and establish the property values that will be passed when 
the application is installed. However, the application will not be installed at this time. 

– Follow the prompts for the Setup Wizard until you are prompted to: Enter a title for 
the application. 

– Change the default value of Congratulations! to Great Job!  

– Click Next. 

– Leave the message value as is. 

– Continue through the Setup program and then click Finish. 

– You are returned to the Installation Simulation page of the Radia Publisher. 

 
Do not click Next yet. 

c Click Features. 

– This allows you to configure the available MSI Features. Leave the default configuration 
for your application. 

d Click Properties. 

– Scroll down the Properties list to VARIABLE_APPTITLE. The check box to the left is 
marked because the default value of Congratulations! was overwritten when you 
entered Great Job! during the Installation Simulation.  
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– If desired, you can modify other Property values at this time. For example, right-click 
ARPHELPLINK and select Set the Install Value. In the Install Value text box, type 
support.openview.hp.com and click OK. 

– The check box to the left of ARPHELPLINK is marked as well to indicate its value has 
been modified. 

5 If you choose, you can review the other publishing options, such as Transforms and Upgrade 
Options. However, these options do not apply to the current application.  

For more information on any Publishing option, refer to the Advanced Publishing Mode topic in 
the Publisher Guide for the HP OpenView Administrator Workstation using Radia. 

6 After completing the steps above, click Next. 

7 The Admin Install Point is created and then the Package Information window opens. Complete 
this window as follows: 

a In the Name field, type CONGRATS_RSM.  

b In the Display name field, type CAP Software Congrats. 

c Leave the Domain set to SOFTWARE. 

d Leave the Description of CAP Software Congrats. 

e In the Release text box, type 1.0. 

f In Limit package to systems with list box, select all Windows operating systems. 

 
Hardware settings are not needed for this package, because the application has no 
minimum requirements for memory or processor speed. 

g Click Next. 

8 On the Service Information window, complete the following: 

a In the Name field, type CONGRATS_RSM. 

b In the Display name field, type CAP Software Congrats. 

c In the Assignment type area, change Assignment type to Optional, and Management Type to 
Manual. 

d Click Next. 

9 On the Publish windows, click Publish. 

10 When publishing is complete, click Finish and then Yes to exit. 

You application has been published. If you want to see the application, you can use the Management 
Portal and click the ZONE: Demo icon, and then click Configuration, PRIMARY, Software, Software 
Services and you will see CAP Software Congrats listed.  
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If you want practice further, you can entitle this application to a user such as Lisa Black. Then, go to 
the target device and open the Software Catalog. The application should appear in the catalog and 
you can install it. 
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A Tips and Tricks 

Configuring Shared Folders in VMware 

You may need to access information from your host machine. One way to do this is to set up shared 
folders.  

To set up shared folders  

 
You can use these instructions to set up shared folders on any virtual machine.  

1 In VMware, right-click the HPOV Config Mgmt Server tab and select Settings. 

2 Select the Options tab. 

3 Click Shared Folders (which are enabled by default). 

4 Click Add… 

The Welcome to the Add Shared Folder Wizard opens.  

5 Click Next. 

6 In the Name text box, type the name for the Shared Folder. For example, you may have folders 
named Host Desktop or Host C Drive. 

7 In the Host folder text box, browse to the location of the host folder. 

8 Click OK. 

9 Complete the wizard without making any changes. 

10 Click OK. 

11 Repeat this procedure for each shared folder that you want to create. 

12 To access your shared folders, open Windows Explorer and then go to My Network Places, 
Entire Network, VMware Shared Folders. 

13 Expand VMware Shared Folders until you see the folders that you created. You can map these as 
network drives for quick access. 

Setting Default Options for Notify Commands 

If you often repeat a Notify operation, you may want to modify the appropriate Notify task so that it 
has default options that pertain to your organization. To do this, you will navigate to a specific Notify 
task and then modify the properties for the appropriate type of Notify, such as Radia Full Connect. 

To set default options for Notify commands 

1 In the Navigation area, go to Directory, Zone, Configuration. 

2 In the workspace, click Tasks. 

2 In the workspace, click the Notify task that you want to modify, such as Notify. 
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3 In the workspace, click the type of Notify operation for which you want to set defaults, such as 
Full Connect. 

 

The Options Properties dialog box opens. 

4 In the Model Administration task group, click Modify. 

The Modify Options dialog box opens. 

5 Modify the fields as necessary. 

— In the Display Name text box, change the display name of the task. 

— In the Command text box, change the default command line for the Notify that you want to 
perform. 

— In the Port number text box, change the default port number that the Notify daemon will be 
listening on. 

— If necessary, in the User text box, type the default user name for the target device. 

— If necessary, in the User Password text box, type the default password for the target device. 

6 Click Modify. 

The Options Properties dialog box opens and you can review your changes. 

The next time you initiate a Notify and select the notification type that you modified, the new default 
settings appear in the Submit Notify—Notify Opts dialog box. 

Adding Shortcuts to Your Management Portal Desktop 

You can create shortcuts to your desktop in the Management Portal so that you do not have to drill 
down to items that you use often. 

To add a shortcut to the desktop 

1 Use the Navigation area to go to the item for which you want to create a shortcut. For example, 
the figure shows an example of navigating to the *Default Group* for devices by selecting Zone, 
Groups, and then Default Group. 
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Legend 

a Click  on toolbar to add desktop shortcut for current location. 

2 When you reach the desired item, click  on the Toolbar. 

The Add Shortcut to (selected location) window opens, requesting a confirmation. 

3 Click  to confirm that you want to add the shortcut. 

or 

Click  to indicate that you do not want to add the shortcut. 

If you click , the shortcut is added to the desktop. 

Below, you can see that a shortcut to Default Group has been added to the Desktop. 
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